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   Objectives 
 After completing this lab, you will know how to: 

 ● 1   Develop a document as well as enter and edit text.  

 ● 2   Insert and delete text and blank lines.  

 ● 3   Use spelling and grammar checking.  

 ● 4   Use AutoCorrect.  

 ● 5   Cut and copy text.  

 ● 6   Change fonts and type sizes.  

 ● 7   Bold and color text.  

 ● 8   Change alignment.  

   ● 9 Insert and size pictures.  

 ● 10   Print a document.  

   ● 11 Use a template.   

 Creating and Editing a Document   Lab 1 
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  As a recent college graduate, you have accepted a job 

as advertising coordinator for Adventure Travel Tours, a 

specialty travel company that organizes active adven-

ture vacations. The company is headquartered in Los 

Angeles and has locations in other major cities through-

out the country. You are responsible for coordination of 

the advertising program for all locations. This includes 

the creation of many kinds of promotional materials: 

brochures, flyers, form 

letters, news releases, 

advertisements, and a 

monthly newsletter. You 

are also responsible for 

creating Web pages 

for the company Web 

site. 

 Adventure Travel 

Tours is very excited 

about four new tours 

planned for the upcom-

ing year. They want to 

promote them through informative presentations held 

throughout the country. Your first job as advertising 

coordinator will be to create a flyer advertising the 

four new tours and the presentations about them. 

The flyer will be modified according to the location of 

the presentation. 

     The software tool you will use to create the flyer 

is the word processing application Microsoft Office 

Word 2010. It helps 

you create docu-

ments such as letters, 

reports, and research 

papers. In this lab, you 

will learn how to enter, 

edit, and print a docu-

ment while you create 

the flyer (shown right) 

to be distributed in a 

mailing to Adventure 

Travel Tours clients.          

 Adventure Travel Tours 

   CASE STUDY 
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Entering and editing text is 

simplified with many of Word’s 

AutoCorrect features.

Formatting enhances 

the appearance of a 

document.

F i h

Pictures add visual interest to a 

document.

Pi dd i l i
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WD1.4 Lab 1: Creating and Editing a Document

  Concept Preview 

  Creating New Documents 

  Adventure Travel Tours has recently upgraded their computer systems at 
many of their locations across the country. As part of the upgrade, they have 
installed the latest version of the Microsoft Office 2010 suite of applications. 
You are very excited to see how this new and powerful application can help 
you create professional letters and reports as well as eye-catching flyers and 
newsletters. Your first project with Adventure Travel Tours is to create a flyer 
about four new tours.  

   DEVELOPING A DOCUMENT 

 The development of a document follows several steps: plan, enter, edit, format, 
and preview and print.               

Step Description

Plan The first step in the development of a document is to understand the purpose of the 
document and to plan what your document should say.

Enter After planning the document, you enter the content of the document by typing the text 
using the keyboard.

Edit While creating a document, you will need to edit it to correct typing, spelling, and 
grammar errors. You will also probably spend much time revising the document by 
adding and deleting information and by reorganizing it to make the meaning clearer.

Format Enhancing the appearance of the document by formatting the text makes it more 
readable and attractive and makes it easier to find information and emphasize important 
points. This is usually performed when the document is near completion, after all edits 
and revisions have been completed. It includes many features such as boldfaced text, 
italics, and bulleted lists.

Preview and Print The last step is to preview and print the document. When previewing, you check the 
document’s overall appearance and make any final changes before printing.

  The following concepts will be introduced in this lab: 

     1 Grammar Checker  The grammar checker advises you of incorrect grammar as you create 
and edit a document, and proposes possible corrections.  

   2 Spelling Checker  The spelling checker advises you of misspelled words as you create 
and edit a document, and proposes possible corrections.  

   3    AutoCorrect    The AutoCorrect feature makes some basic assumptions about the text you 
are typing and, based on these assumptions, automatically corrects the entry.  

   4 Word Wrap  The word wrap feature automatically decides where to end a line and wrap 
text to the next line based on the margin settings.  

   5 Alignment  Alignment is the positioning of text on a line between the margins or indents. 
There are four types of paragraph alignment: left, centered, right, and justified.  

   6 Graphics  A graphic is a nontext element or object such as a drawing or picture that can 
be added to a document.  

   7 Templates  A template is a document file that stores predefined settings and other elements 
such as graphics for use as a pattern when creating documents.      
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Having Trouble?

See “Common Interface Features,” on 
page IO.14, for information on how to 
start the application and use features 
that are common to all Office 2010 
applications.

Additional Information

The Ribbon may display additional tabs 
if other application add-ins associated 
with Office are enabled.

 Additional Information 

If the ruler is not displayed, click    
View Ruler above the vertical scroll bar 
to turn it on. You also can temporarily 
display the horizontal or vertical ruler 
by pointing to the top or left edge of the 
document window.

 Additional Information 

The mouse pointer also may appear in 
other shapes, depending upon the task 
being performed.

 Creating New Documents WD1.5

1

 You will find that you will generally follow these steps in the order listed 
above for your first draft of a document. However, you will probably retrace 
steps such as editing and formatting as the final document is developed. 

 During the planning phase, you spoke with your manager regarding the 
purpose of the flyer and the content in general. The primary purpose of the 
flyer is to promote Adventure Travel’s new tours. A secondary purpose is to 
advertise the company in general. 

 You plan to include specific information about the new tours in the flyer as 
well as general information about Adventure Travel Tours. The content also 
needs to include information about the upcoming new tour presentations. 
Finally, you want to include information about the Adventure Travel Web site.  

  EXPLORING THE WORD 2010 WINDOW 

 You will use the word processing application Microsoft Office Word 2010 to 
create a flyer promoting the new tours and presentations. 

Ribbon

Insertion point 

File nameHome tab 

Horizontal ruler 

Mouse pointer 

Click to display/hide rulers

Vertical ruler 

Blank document is displayed 

in document window 

Figure 1.1

 The Word 2010 Ribbon below the title bar displays command tabs that pro-
vide access to the commands and features you will use to create and modify a 
document. 

 The large area below the Ribbon is the    document window.    It currently dis-
plays a blank Word document. The    insertion point,    also called the    cursor,    is 
the blinking vertical bar that marks your location in the document. A vertical 
and horizontal    ruler    may be displayed along both edges of the document win-
dow. The horizontal ruler at the top of the document window shows the line 
length in inches and is used to set margins, tab stops, and indents. The vertical 
ruler along the left edge shows the page length in inches and shows your line 
location on the page. 

 The mouse pointer may appear as an I-beam (see  Figure 1.1 ) or a left- or 
right-facing arrow, depending on its location in the window. When it appears 

      •  Start Word 2010.   

   •  If necessary, 

maximize the Word 

2010 application 

window.    

 Your screen should be similar to  

Figure 1.1
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 Additional Information 

You also can change views using 
commands in the Document Views 
group of the View tab.

WD1.6 Lab 1: Creating and Editing a Document

as an I-beam, it is used to move the cursor, and when it appears as an arrow, it 
is used to select items.       

View buttons  

Mouse pointer

Print Layout view 

is current view

Current zoom 

percentage 

Zoom feature 

Word count 

indicator 

Page count 

indicator 

Status bar 

  Figure 1.2       

  CHANGING THE DOCUMENT VIEW 

 The status bar at the bottom of the window displays the page and word count 
indicators. The page indicator identifies the page of text that is displayed 
onscreen of the total number of pages in the document. The word count indi-
cator displays the number of words in a document. When you first start Word, 
a new blank document consisting of a single page and zero words is opened. 

 The right end of the status bar displays five buttons that are used to change 
the document view and a document zoom feature. Word includes several 
views that are used for different purposes. The different document views are 
described in the table below.               

Document View Button Effect on Text

Print Layout Shows how the text and objects will appear on the printed page. 
This is the view to use when adjusting margins, working in columns, 
drawing objects, and placing graphics.

Full Screen Reading Shows the document only, without Ribbon, status bar, or any other 
features. Useful for viewing and reading large documents. Use to 
review a document and add comments and highlighting.

Web Layout Shows the document as it will appear when viewed in a Web browser. 
Use this view when creating Web pages or documents that will be 
displayed on the screen only.

Outline Shows the structure of the document. This is the view to use to plan 
and reorganize text in a document.

Draft Shows text formatting and simple layout of the page. This is the best 
view to use when typing, editing, and formatting text.

2

      •  Move the mouse 

pointer into the left 

edge of the blank 

document to see it 

appear as     .   

   •  Move the mouse 

pointer to the Ribbon 

to see it appear as     .    

 Your screen should be similar 

to  Figure 1.2
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 Additional Information 

 Pointing to the items on the status bar 
displays a ScreenTip that identifies the 
feature. 

1

      •  Drag the Zoom Slider 

to the left to reduce 

the zoom until the 

entire page is visible.    

 Your screen should be similar 

to  Figure 1.3

Having Trouble?

See “Using the Zoom Feature” on page 
IO.33 in the Introduction to Microsoft 
Office 2010 to review the document 
zoom feature.

 Creating New Documents WD1.7

 Print Layout view is the view you see when first starting Word or opening a 
document. You can tell which view is in use by looking at the view buttons. 
The button for the view that is in use appears highlighted (see  Figure 1.2 ). 
The zoom setting for each view is set independently and remains in effect 
until changed to another zoom setting. Initially the zoom percentage for Print 
Layout view is 100%. At this percentage, the document appears as it will when 
printed.   

 You will “zoom out” on the document to see the entire page so you can bet-
ter see the default document settings.       

1-inch left and right margins 

Text space of 

6.5 inches 

Text space 

1-inch top and 

bottom margins 

Entire page 

is visible 

Click to decrease 

in 10% increments 

Drag Zoom Slider to 

change percentage

  Figure 1.3            

 At this zoom percentage, the entire page is displayed and all four edges of the 
paper are visible. It is like a blank piece of paper that already has many pre-
defined settings. These settings, called    default    settings, are generally the most 
commonly used settings. The default settings include a standard paper-size 
setting of 8.5 by 11 inches, 1-inch top and bottom margins, and 1-inch left and 
right margins. 

 You can verify many of the default document settings by looking at the 
information displayed in the rulers. The shaded area of the ruler identifies the 
margins and the white area identifies the text space. The text space occupies 
6.5 inches of the page. Knowing that the default page size is 8.5 inches wide, 
this leaves 2 inches for margins: 1 inch for equal-sized left and right margins. 
The vertical ruler shows the entire page length is 11 inches with 1-inch top and 
bottom margins, leaving 9 inches of text space. 

 You will use Draft view to create the flyer about this year’s new tours. You 
will use the View tab to change both the view and the Zoom percentage.         
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 •  Open the View tab. 

   •  From the Document 

Views group, 

click     .   

   •  If necessary, choose 

Ruler in the Show 

group     to display the 

ruler.   

   •  From the Zoom group, 

click     .   

  Your screen should be similar 

to    Figure 1.4   

Additional Information

The vertical ruler is not displayed in 
Draft view.

Having Trouble?

Click the box next to an option to select 
or deselect (clear the checkmark).

WD1.8 Lab 1: Creating and Editing a Document

First line indent marker Right indent marker 

Left margin boundary at 0 Right margin boundary at 6.5 

End-of-file marker 

Vertical ruler not displayed

Page margins not displayed 

Current zoom percent

Select to display ruler

  Figure 1.4 

      Increasing the zoom to page width increases the magnification to 154% and 
displays the full text area in the document window. In Draft view, the margins 
and the edges of the page are not displayed. This allows more space on the 
screen to display document content. This view also displays the    end-of-file 
marker,    the solid horizontal line that marks the last-used line in a document.       

 The ruler also displays other default settings. The symbol    at the zero posi-
tion is the first-line indent marker and marks the location of the left paragraph 
indent. The    symbol on the right end of the ruler line at the 6.5-inch position 
marks the right paragraph indent. Currently, the indent locations are the same 
as the left and right margin settings.    

  Entering Text 

  Now that you understand the purpose of the flyer and have a general idea of 
the content, you are ready to enter the text. As you type, you will probably 
make simple typing errors that you want to correct. Word includes many fea-
tures that make entering text and correcting errors much easier. These fea-
tures include checking for spelling and grammar errors, auto correction, and 
word wrap. You will see how these features work while entering the title and 
first paragraph of the flyer.  

   TYPING TEXT 

 The first line of the flyer will contain the text “Adventure Travel Tours New 
Adventures.” As you enter this line of text, include the intentional error identi-
fied in italic. 
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      •  Type Adventure 
Traveel   (do not 

press space after 

typing the last letter).    

 Your screen should be similar 

to  Figure 1.5

Additional Information

The status bar also can display additional 
information such as the horizontal 
position of the cursor on the line and the 
line number. To customize the status bar, 
right-click the status bar and select the 
features you want displayed from the 
status bar context menu.

 Having Trouble? 

To review the basics of moving the 
cursor and editing a document, refer to 
the “Entering and Editing Text” section 
on page IO.34 of the Introduction to 
Microsoft Office 2010.

 Entering Text WD1.9

Cursor shows where next 

character you type will appear 

Number of words in document 

  Figure 1.5 

 Notice that the status bar now tells you that there are two words in the document. 
 Next, you need to correct the typing error by deleting the extra e in the word 

travel. Then you will complete the first line of the flyer.           

Blank lines inserted by pressing e

  Figure 1.6 

      The first line of the flyer is now complete. Pressing the first  e    ended the 
first line of text and inserted a blank line. The next two inserted blank lines.  

2

      •  Press   A     or position 

the I-beam between 

the e and l and click.   

   •  Press   B     to 

remove the extra e.   

   •  Press   S     or click at 

the end of the line.   

   •  Press   z    .   

   •  Type   Tours 
four new 
adventures  

 and correct any 

typing errors as you 

make them using  

 B     or   D   .  

   •  With the cursor 

positioned at the 

end of the line, press  

 e     3 times.    

 Your screen should be similar 

to  Figure 1.6
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      •  Open the Home tab 

and click      Show/

Hide in the Paragraph 

group.    

 Your screen should be similar 

to  Figure 1.7

 Another Method 

You also can use the keyboard shortcut 
 c     +  * to display formatting marks.

WD1.10 Lab 1: Creating and Editing a Document

  REVEALING FORMATTING MARKS 

 While creating a document, Word automatically inserts formatting marks 
that control the appearance of your document. These marks are not displayed 
automatically so that the document is not cluttered. Sometimes, however, it 
is helpful to view the underlying formatting marks. Displaying these marks 
makes it easy to see, for example, if you have added an extra space between 
words or at the end of a sentence.           

Displays formatting marks

End line by pressing e
Entered space by 

pressing z

Inserted blank lines by pressing e

  Figure 1.7 

      The document now displays the formatting marks. The    paragraph mark 
character on the line above the cursor represents the pressing of  e    that 
created the blank line. The    character at the end of the text represents the 
pressing of  e    that ended the line and moved the cursor to the beginning of 
the next line. Between each word, a dot shows where the  z    was pressed. 
Formatting marks do not appear when the document is printed. You can con-
tinue to work on the document while the formatting marks are displayed, just 
as you did when they were hidden. 

 You have decided you want the flyer heading to be on two lines, with the 
words “four new adventures” on the second line. To do this, you will insert a 
blank line after the word Tours. You will move the cursor to the location in the 
text where you want to insert the blank line. 
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 Having Trouble? 

If the green underline is not displayed, 
open the File tab, click   , 
Proofing, and select the “Check spelling 
as you type”, “Mark grammar errors as 
you type”, and “Check grammar with 
spelling” options.

 Identifying and Correcting Errors Automatically WD1.11

Ended line 

Inserted blank line 

Green wavy line indicates a grammar error

Indicates an error 

in the document 

  Figure 1.8 

      All the text to the right of the cursor when you pressed  e    moved down to 
the beginning of the next line. Then as you continued to work on the docu-
ment, the formatting marks adjusted automatically.    

  Identifying and Correcting Errors Automatically 

  Notice that a green wavy underline appears under the word “four.” This indi-
cates an error has been detected.     

 As you enter text, Word constantly checks the document for spelling and 
grammar errors. The Spelling and Grammar Status icon in the status bar dis-
plays an animated pencil icon    while you are typing, indicating Word is 
checking for errors as you type. When you stop typing, it displays either a blue 
checkmark   , indicating the program does not detect any errors, or a red 
X   , indicating the document contains an error. 

 In many cases, Word will automatically correct errors for you. In other 
cases, it identifies the error by underlining it. The different colors and designs 
of underlines indicate the type of error that has been identified. In addition to 
identifying the error, Word provides suggestions as to the possible correction 
needed.  

   CHECKING GRAMMAR 

 In addition to the green wavy line under “four,” the Spelling and Grammar 
Status icon appears as    in the status bar. This indicates that a spelling or 
grammar error has been located. The green wavy underline below the error 
indicates it is a grammar error.     

2

      •  Click to the left of the 

dot after the “s” in 

“Tours”.    

   •  Press   e     2 times.   

   •  Press   D     to 

remove the space 

at the beginning of 

the line.   

   •  Press   Z    .    

 Your screen should be similar 

to  Figure 1.8
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      •  Right-click the word 

“four” to open the 

context menu.    

 Your screen should be similar 

to  Figure 1.9

Having Trouble?

Review context menus in the “Common 
Office 2010 Features” section on page 
IO.51 in the Introduction to Microsoft 
Office 2010. If the wrong context menu 
appears, you probably did not have the 
I-beam positioned on the error with the 
green wavy line. Press  q    or click 
outside the menu to cancel it and try 
again.

 Additional Information 

A dimmed menu option means it is 
currently unavailable.

 Additional Information 

You will learn about using the Mini 
toolbar shortly.

WD1.12 Lab 1: Creating and Editing a Document

Mini toolbar 

Available options 

Right-click on error to see suggested 

correction in context menu 

  Figure 1.9 

 The Word Mini toolbar and a context menu containing commands related 
to the grammar error are displayed. The first item on the menu is the sug-
gested correction, “Four.” The grammar checker indicates you should capi-
talize the first letter of the word because it appears to be the beginning of a 
sentence. It also includes four available commands that are relevant to the 
item, described below.         

Command Effect

Ignore Once Instructs Word to ignore the grammatical error in this sentence.

Grammar Opens the grammar checker and displays an explanation of the error.

About This Sentence Provides help about the grammatical error.

Look up Looks up word in dictionary.

 To make this correction, you could simply choose the correction from the 
menu and the correction would be inserted into the document. Although, in 
this case, you can readily identify the reason for the error, sometimes the rea-
son is not so obvious. In those cases, you can open the grammar checker to 
find out more information. 

The    grammar checker    advises you of incorrect grammar as you create and edit a document, and proposes 
possible corrections. Grammar checking occurs after you enter punctuation or end a line. If grammatical errors 
in subject-verb agreements, verb forms, capitalization, or commonly confused words, to name a few, are 
detected, they are identified with a wavy green line. You can correct the grammatical error by editing it or you 
can open the context menu for the identified error and display a suggested correction. Because not all identified 
grammatical errors are actual errors, you need to use discretion when correcting the errors.

1 Concept   Grammar Checker 
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     Additional Information 

Moving the cursor using the keyboard 
or mouse deselects or removes the 
highlight from text that is selected.

 Identifying and Correcting Errors Automatically WD1.13

Line containing 

error is selected 
Type of error 

Location of error 

Suggested correction 

Click to 

make suggested 

correction 

  Figure 1.10 

      The Grammar dialog box identifies the type and location of the grammati-
cal error in the upper text box and the suggested correction in the Sugges-
tions box. The line in the document containing the error is also highlighted 
(selected) to make it easy for you to see the location of the error. You will make 
the suggested change. 

      

Text deselected 

Error corrected 

by capitalizing “F” 

No more errors 

located 

  Figure 1.11 

 The error is corrected, the wavy green line is removed, and the Spelling and 
Grammar Status icon returns to   .  

2

      •  Choose Grammar.    

 Your screen should be similar 

to  Figure 1.10

3

      •  Click     .   

   •  Move to the blank 

line at the end of the 

document.    

 Your screen should be similar 

to  Figure 1.11
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  CHECKING SPELLING 

 Now you are ready to type the text for the first paragraph of the flyer. Enter the 
following text, including the intentional spelling errors. 

Misspelled words identified 

Errors located 

  Figure 1.12 

      As soon as you complete a word by entering a space, the program checks the 
word for spelling accuracy.     

1

      •  Type Attention 
adventire 
travellars!   

   •  Press   z    .    

 Your screen should be similar 

to  Figure 1.12

 The    spelling checker    advises you of misspelled words as you create and edit a document, and proposes pos-
sible corrections. The spelling checker compares each word you type to a    main dictionary    of words supplied 
with the program. The main dictionary includes most common words. If the word does not appear in the main 
dictionary, it then checks the custom dictionary. The    custom dictionary    consists of a list of words such as 
proper names, technical terms, and so on, that are not in the main dictionary and that you want the spelling 
checker to accept as correct. Adding words to the custom dictionary prevents the flagging as incorrect of spe-
cialized words that you commonly use. Word shares custom dictionaries with other Microsoft Office applications 
such as PowerPoint. 

 If the word does not appear in either dictionary, the program identifies it as misspelled by displaying a red 
wavy line below the word. You can then correct the misspelled word by editing it. Alternatively, you can display 
a list of suggested spelling corrections for that word and select the correct spelling from the list to replace the 
misspelled word in the document. 

Word automatically identified the two words “adventire travellars” as misspelled by underlining them with a 
wavy red line. The quickest way to correct a misspelled word is to select the correct spelling from a list of sug-
gested spelling corrections displayed on the context menu.

2 Concept  Spelling Checker 
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      •  Right-click on 

“adventire” to display 

the context menu.    

 Your screen should be similar 

to  Figure 1.13

     Another Method 

You also can position the cursor on the 
item you want to display a context menu 
for and press  s     +   0    to open the 
menu.

 Identifying and Correcting Errors Automatically WD1.15

Suggested corrections 

Context menu 

  Figure 1.13      

 A context menu containing suggested correct spellings is displayed. The con-
text menu also includes several related menu options, described in the follow-
ing table.         

Option Effect

Ignore Instructs Word to ignore the misspelling of this word for this occurrence only.

Ignore All Instructs Word to ignore the misspelling of this word throughout the rest of this session.

Add to Dictionary Adds the word to the custom dictionary list. When a word is added to the custom diction-
ary, Word will always accept that spelling as correct.

AutoCorrect Adds the word to the AutoCorrect list so Word can correct misspellings of it automatically 
as you type.

Language Sets the language format, such as French, English, or German, to apply to the word.

Spelling Starts the spell-checking program to check the entire document. 

Look Up Searches reference tools to locate similar words and definitions.

 Sometimes there are no suggested replacements because Word cannot 
locate any words in its dictionary that are similar in spelling; or the sugges-
tions are not correct. If this occurs, you need to edit the word manually. In this 
case, the first suggestion is correct. 
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Selected corrections 

replace misspelled words 

No spelling or 

grammar error

  Figure 1.14 

      The spelling corrections you selected replace the misspelled words in the doc-
ument. The Spelling and Grammar status icon returns to   , indicating that, 
as far as Word is able to detect, the document is free from errors.  

  USING AUTOCORRECT 

 As you have seen, as soon as you complete a word by entering a space or 
punctuation, the program checks the word for grammar and spelling accu-
racy. Also, when you complete a sentence and start another, additional checks 
are made. Many spelling and grammar corrections are made automatically for 
you as you type. This is part of the AutoCorrect feature of Word.     

3

      •  Choose “adventure”.   

   •  Correct the spelling 

for “travellars”.    

 Your screen should be similar 

to  Figure 1.14

 The    AutoCorrect    feature makes some basic assumptions about the text you are typing and, based on these 
assumptions, automatically corrects the entry. The AutoCorrect feature automatically inserts proper capitalization 
at the beginning of sentences and in the names of days of the week. It also will change to lowercase letters any 
words that were incorrectly capitalized because of the accidental use of the  s    key. In addition, it also cor-
rects many common typing and spelling errors automatically. 

 One way the program automatically makes corrections is by looking for certain types of errors. For example, 
if two capital letters appear at the beginning of a word, Word changes the second capital letter to a lowercase 
letter. If a lowercase letter appears at the beginning of a sentence, Word capitalizes the first letter of the first 
word. If the name of a day begins with a lowercase letter, Word capitalizes the first letter. When Spelling Checker 
provides a single suggested spelling correction for the word, the program will automatically replace the incorrect 
spelling with the suggested replacement. 

Another way the program makes corrections is by checking all entries against a built-in list of AutoCorrect 
entries. If it finds the entry on the list, the program automatically replaces the error with the correction. For 
example, the typing error “withthe” is automatically changed to “with the” because the error is on the AutoCor-
rect list. You also can add words to the AutoCorrect list that you want to be automatically corrected.

3 Concept  AutoCorrect 
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     Having Trouble? 

The “Capitalize first letter of sentences” 
and “Replace text as you type” 
AutoCorrect features must be on. Open 
the File tab, click   , Proofing, 

  , and select these 
options if necessary.

 Identifying and Correcting Errors Automatically WD1.17

 Enter the following text, including the errors (identified in italics). 

Spelling error located 

Separated into two words

First letter capitalized

Spelling automatically corrected 

Errors located 

  Figure 1.15 

 The first letter of the word “attend” was automatically capitalized because, 
as you were typing, the program determined that it is the first word in a sen-
tence. In a similar manner, it corrected the spelling of “presentation” and sepa-
rated the words “about the” with a space. The AutoCorrect feature corrected 
the spelling of “presentation” because it was the only suggested correction for 
the word supplied by the Spelling Checker. The word “lern” was not corrected 
because there are several suggested spelling corrections. 

 When you rest the mouse pointer near text that has been corrected auto-
matically or move the cursor onto the word, a small blue box appears under 
the first character of the word. The blue box changes to the    AutoCorrect 
Options button when you point to it.       

1

      •  Press   j     to move to 

the end of the line.   

   •  Press   e    .   

   •  Type   attend a 
presenta  a  tion 
to l  e  rn 
aboutthe   

   •  Press   z    .    

 Your screen should be similar 

to  Figure 1.15
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2

      •  Point to the word 

“Attend” to display 

the blue box.   

   •  Point to the blue box.   

   •  Click     

 AutoCorrect Options.    

 Your screen should be similar 

to  Figure 1.16

  Having Trouble? 

 If your screen does not display the blue 
box, open the File tab, click   , 
Proofing,   , and select 
the Show AutoCorrect Options buttons 
check box.  

 Another Method 

You also can open the File tab, 
click   , Proofing, 

  ,    to 
add a word to the exceptions list.

WD1.18 Lab 1: Creating and Editing a Document

AutoCorrect Options button displays when you point to the 

blue box below a word that has been automatically corrected

AutoCorrect 

Options menu 

  Figure 1.16 

      Each time Word uses the AutoCorrect feature, the AutoCorrect Options button 
is available. The AutoCorrect Options menu allows you to undo the AutoCor-
rection or to permanently disable the AutoCorrection for the remainder of 
your document. The Control AutoCorrect Options command is used to change 
the settings for this feature. In some cases, you may want to exclude a word 
from automatic correction. You can do this by adding the word to the excep-
tions list so the feature will be disabled for that word. If you use  B    to 
delete an automatic correction and then type it again the way you want it to 
appear, the word will be automatically added to the exceptions list.     

 You want to keep all the AutoCorrections that were made and correct the 
spelling for “lern”.         

3

 •  Click outside the menu to close it. 

   •  Open the spelling context menu for “lern” and choose “learn”.   

 The spelling is corrected, and the spelling indicator in the status bar indicates 
that the document is free of errors.    

  Using Word Wrap 

  Now you will continue entering more of the paragraph. As you type, when the 
text gets close to the right margin, do not press  e    to move to the next line. 
Word will automatically wrap words to the next line as needed.     
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   Additional Information 

Generally, when using a word processor, 
separate sentences with one space 
after a period rather than two spaces, 
which was common when typewriters 
were used.

 Additional Information 

You can continue typing to ignore the 
date suggestion.

 Using Word Wrap WD1.19

 Enter the following text to complete the sentence.       

Right margin boundary 

Text wrapped automatically 

to next line

  Figure 1.17 

 The program has wrapped the text that would overlap the right margin to the 
beginning of the next line. 

 You have a meeting you need to attend in a few minutes and want to con-
tinue working on the document when you get back. You decide to add your 
name and the current date to the document. As you type the first four char-
acters of the month, Word will recognize the entry as a month and display 
a ScreenTip suggesting the remainder of the month. You can insert the sug-
gested month by pressing  e   . Then enter a space to continue the date and 
another ScreenTip will appear with the complete date. Press  e    again to 
insert it.           

The    word wrap    feature automatically decides where to end a line and wrap text to the next line based on the 
margin settings. This feature saves time when entering text because you do not need to press  e    at the end 
of a full line to begin a new line. The only time you need to press  e    is to end a paragraph, to insert blank 
lines, or to create a short line such as a salutation. In addition, if you change the margins or insert or delete text 
on a line, the program automatically readjusts the text on the line to fit within the new margin settings. Word 
wrap is common to all word processors.

4 Concept   Word Wrap 

1

      •  Press   j     to move to 

the end of the line.   

   •  Type   earth’s 
greatest 
unspoiled 
habitats and 
find out how 
you can 
experience the 
adventure of a 
lifetime.   

   •  Correct any spelling 

or grammar errors 

that are identified.    

 Your screen should be similar 

to  Figure 1.17
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 Having Trouble? 

Review saving files in the “Saving 
a File” section on pg. IO.52 in the 
Introduction to Microsoft Office 2010.

WD1.20 Lab 1: Creating and Editing a Document

Turn off the display of formatting marks 

  Figure 1.18 

      As you have seen, in many editing situations, it is helpful to display the for-
matting marks. However, for normal entry of text, you will probably not need 
the marks displayed. Now that you know how to turn this feature on and off, 
you can use it whenever you want when entering and editing text. 

 Before leaving to attend your meeting, you want to save your work to a file. 
You will name the file Flyer and use the default document type (.docx).       

2

      •  Move to the end of 

the sentence and 

press   e     twice.   

   •  Type   your name   

   •  Press   e    .   

   •  Type the   current 
date   beginning 

with the month and 

when the ScreenTips 

appear for the month 

and the complete 

date, press   e     to 

insert them.   

   •  Press   e     twice.   

   •  Click      Show/Hide 

to turn off the display 

of formatting marks.    

 Your screen should be similar 

to  Figure 1.18
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 Having Trouble? 

Review closing files in the “Closing 
a File” section on pg. IO.60 in the 
Introduction to Microsoft Office 2010.

 Editing Documents WD1.21

New file name 

  Figure 1.19 

      The document is saved as Flyer.docx at the location you selected, and the new 
file name is displayed in the Word title bar. 

 Finally, you want to close the document while you attend your meeting. 

3

      •  Click      Save in the 

Quick Access Toolbar.   

   •  Select the location 

where you want to 

save your file.   

   •  If necessary, drag to 

select the proposed 

file name in the File 

Name text box to 

highlight the text.   

   •  Type Flyer.   

   •  Click      to 

save your document 

as a Word document.        

 Your screen should be similar 

to  Figure 1.19

4

      •  Open the File tab and click     .    

 Now the Word window displays an empty document window.       

  Editing Documents 

  You asked your assistant to enter the remaining information in the flyer for 
you while you attended the meeting. Upon your return, you find a note from 
your assistant on your desk. The note explains that he had a little trouble 
entering the information and tells you that he saved the revised file as Flyer1. 
You want to open the file and continue working on the flyer.       
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1

      •  Open the File tab and 

click     .          

    •  Select the location 

containing your data 

files.   

   •  Select wd01_Flyer1.   

   •  Click     .   

   •  Scroll the document 

window to see the 

entire contents of the 

flyer.   

   •  Click anywhere in the 

last line to move the 

cursor.    

 Your screen should be similar 

to  Figure 1.20

 Having Trouble? 

Review opening files in the “Opening 
a File” section on pg. IO.28 in the 
Introduction to Microsoft Office 2010.

     Having Trouble? 

Review how to navigate a document in 
the “Scrolling the Document Window” 
section on page IO.30 of the Introduction 
to Microsoft Office 2010.

WD1.22 Lab 1: Creating and Editing a Document

Cursor moved to last line 

Click to scroll down 

through document

  Figure 1.20 

 The file containing the additional content you asked your assistant to add 
to the flyer is opened and displayed in the document window. After looking 
over the flyer, you have identified several errors that need to be corrected and 
changes you want to make to the content. The changes you want to make are 
shown below. 

Delete word

Add “and times”

Change to “held”

Delete junk text

Capitalize first letter

Combine paragraphs

Delete word

Delete sentence

Rearrange order 

of tours
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1

      •  Press   c     +   h    

 to move to the top of 

the document.   

   •  Move the cursor to 

the “a” in “are” in the 

first sentence of the 

paragraph below the 

list of tours.        

    •  Type   and times     

   •  Press   z    .    

 Your screen should be similar 

to  Figure 1.21

 Additional Information 

Throughout these labs, when instructed 
to move to a specific letter in the text, 
this means to move the cursor to the left 
side of the character.

  Additional Information 

 You can replace existing text using 
Overtype mode, in which each character 
you type replaces an existing character. 
This feature is turned on by opening the 
File tab, then clicking   , 
Advanced, and then selecting Use 
overtype mode.  

 Additional Information 

If necessary, refer to the section 
“Selecting Text” on page IO.37 in the 
Introduction to Microsoft Office 2010 
to review this feature.

 Editing Documents WD1.23

      INSERTING AND REPLACING TEXT 

 As you check the document, you see that the first sentence of the paragraph 
below the list of trips is incorrect. It should read: “Presentation dates and 
times are . . . ” The sentence is missing the words “and times.” In addition, you 
want to change the word “made” to “held” in the following sentence. These 
words can easily be entered into the sentence without retyping the entire line. 
This is because Word uses    Insert mode    to allow new characters to be inserted 
into the existing text by moving the existing text to the right to make space 
for the new characters. You will insert the words “and times” after the word 
“dates” in the first sentence.       

Text inserted Word wrap automatically 

readjusts text on line

  Figure 1.21 

      The inserted text pushes the existing text on the line to the right, and the word 
wrap feature automatically readjusts the text on the line to fit within the mar-
gin settings. 

In the second sentence, you want to change the word “made” to “held.” You 
could delete this word and type in the new word, or as you will do next, you 
can select the text and type the new text.                 
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     •  Double-click on 

“made” in the next 

sentence.   

 •  Type   held 

 Your screen should be similar 

to  Figure 1.22

 Having Trouble? 

If you accidentally select the wrong text, 
simply click anywhere in the document 
or press any directional key to clear the 
selection.

WD1.24 Lab 1: Creating and Editing a Document

New text replaced selected text 

  Figure 1.22 

      As soon as you began typing, the selected text was automatically deleted. The 
new text was inserted in the line just like any other text.  

  DELETING TEXT 

 As you continue proofreading the flyer, you see several changes you would 
like to make. The first change is to combine the line “Attention adventure 
 travellers!” with the text in the following paragraph. To do this, you need to 
delete the paragraph mark symbol  after the text “travelers!”. 

Paragraph mark deleted and 

Paragraphs combined

  Figure 1.23 

1

      •  Move to the “A” 

of “Attend” at the 

beginning of the first 

paragraph.   

   •  Press   B    .    

 Your screen should be similar 

to  Figure 1.23
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 Additional Information 

The  c     +   B    key combination 
deletes text to the left of the cursor 
to the beginning of the next group of 
characters.

2

      •  Move to “f” in 

“four” in the second 

sentence below the 

list of tours.   

   •  Press   c     +   D    .    

 Your screen should be similar 

to  Figure 1.24

 Having Trouble? 

Hold down  c    while pressing  D   .

 Editing Documents WD1.25

      You deleted the      that ended the previous line and the paragraph has now 
moved up to the line above. 

 You next want to delete the word “four” from the second sentence in the 
paragraph below the list of tours. The  c     +   D    key combination deletes 
text to the right of the cursor to the beginning of the next group of characters. 
In order to delete an entire word, you must position the cursor at the begin-
ning of the word.     

Entire word deleted 

using c + D Junk text to 

be deleted

  Figure 1.24 

      The word “four” has been deleted. 
 You see that the end of the same sentence contains a section of junk charac-

ters. To remove these characters, you could use  D    and  B    to delete 
each character individually, or  c     +   D    or  c     +   B    to delete each 
word or group of characters. This is very slow, however. Several characters, 
words, or lines of text can be deleted at once by first selecting the text and then 
pressing  D   . 

 The section of characters you want to remove follows the word “hotel” in 
the same sentence. You also decide to delete the entire last sentence of the 
paragraph. 
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      •  Move to “Z” 

(following the word 

“hotel”).   

   •  Drag to the right until 

all the text including 

the space before the 

word “locations” is 

highlighted.        

    •  Press   D    .   

   •  Hold down   c     and 

click anywhere in 

the third sentence of 

the paragraph below 

the list of trips.   

   •  Press   D    .    

  Your screen should be similar 

to    Figure 1.25   

 Additional Information 

When you start dragging over a word, 
the entire word including the space after 
it is automatically selected.

  Having Trouble? 

 Hold down the left mouse button while 
moving the mouse to drag.  

Additional Information

Review the Undo feature in the 
“Undoing Editing Changes”section 
on page IO.43 of the Introduction to 
Microsoft Office 2010.

Another Method

The keyboard shortcut for the Undo 
command is c + Z.

WD1.26 Lab 1: Creating and Editing a Document

Sentence deleted

Junk text deleted

  Figure 1.25 

      The selected junk text and the complete sentence were removed from the flyer.  

  UNDOING EDITING CHANGES 

 After removing the sentence, you decide it may be necessary after all. To 
quickly restore this sentence, you can use    Undo to reverse your last action 
or command. Notice that the Undo button includes a drop-down list but-
ton. Clicking this button displays a list of the most recent actions that can be 
reversed, with the most recent action at the top of the list. When you select an 
action from the drop-down list, you also undo all actions above it in the list. 
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2

      •  Click      Redo 2 

times.    

    •  Open the File tab and 

choose Save As.   

   •  Save the document 

as Flyer1 to your 

solution file location.    

 Your screen should be similar 

to  Figure 1.27

  Another Method 

 The keyboard shortcut is  c     +  Y.  

 Editing Documents WD1.27

Deleted word 

restored

Junk text 

restored

Sentence restored

  Figure 1.26 

      The deleted sentence, junk characters, and the word “four” are restored. You 
will restore two of your corrections and then save the changes you have made 
to the document to a new file. 

      

New file name
Redo restores last Undo action

Using Redo reversed changes 

made using Undo

  Figure 1.27 

1

      •  Open the      Undo 

drop-down list.   

        

   •  Choose Delete Word.    

     Your screen should be similar 

to  Figure 1.26
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  Additional Information 

 You also can use  s     +   3    to cycle 
through and apply the different change 
case options.  

WD1.28 Lab 1: Creating and Editing a Document

    Repeatedly using the    Undo or    Redo buttons performs the actions in 
the list one by one. So that you can see what action will be performed, the but-
ton’s ScreenTips identify the action. 

 The new file name, Flyer1, is displayed in the window title bar. The original 
document file, wd01_Flyer1 is unchanged.  

  CHANGING CASE 

 You also want to delete the word “Four” from the second line of the flyer title 
and capitalize the first letter of each word. Although you could change the 
case individually for the words, you can quickly change both using the Change 
Case command in the Font group. 

Capitalizes the first letter of 

each word in the selection

  Figure 1.28 

      The Change Case drop-down menu allows you to change the case of selected 
words and sentences to the desired case without having to make the change 
manually. You want both words in the title to be capitalized. 

1

      •  Move the cursor to 

the beginning of the 

word “Four”.   

   •  Press   c     +   D    .   

   •  Click in the left 

margin to select the 

entire title line.   

   •  From the Font group, 

click      Change 

Case.    

  Your screen should be similar 

to    Figure 1.28   
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Additional Information

Review how to copy and move 
selections in the “Copying and Moving 
Selections”section on page IO.45 of the 
Introduction to Microsoft Office 2010.

 Copying and Moving Selections WD1.29

First letters 

capitalized

  Figure 1.29 

      The first letter of each word in the title is now capitalized and the highlight is 
removed from the text.    

  Copying and Moving Selections 

  After looking over the letter, you decide to add the company name in several 
other locations and to change the order of the list of tours. To make these 
changes quickly, you can copy and move selections.  

   USING COPY AND PASTE 

 You want to include the company name in the last paragraph of the letter. 
Because the name has already been entered on the first line of the document, 
you will copy the name instead of typing the name again. Before you copy the 
text, you will reveal formatting marks in your document to make sure you’re 
copying exactly what you want. 

2

      •  Choose Capitalize 

Each Word.   

   •  Click anywhere to 

deselect the title line.    

 Your screen should be similar 

to  Figure 1.29
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      •  Click      Show/

Hide to display the 

formatting marks in 

your document.   

   •  Select the text 

“Adventure Travel 

Tours” not including 

the      paragraph 

symbol at the end of 

the line.   

   •  Click      Show/Hide 

to hide the formatting 

marks again.   

   •  Click      Copy in the 

Clipboard group of 

the Home tab.   

   •  Move the cursor to 

the left of “1” in the 

phone number (last 

paragraph).   

   •  Click      Paste in 

the Clipboard group.    

 Your screen should be similar 

to  Figure 1.30

  Another Method 

 The Copy keyboard shortcut 
is  c     +  C. The Paste keyboard 
shortcut is  c     +  V.  

WD1.30 Lab 1: Creating and Editing a Document

Inserts system Clipboard contents

Copies selection to system Clipboard

Copied selection 

inserted in document

Paste Options button

  Figure 1.30 

      The copied selection is inserted at the location you specified. The    Paste 
Options button appears automatically whenever a selection is pasted. It is 
used to control the format of the pasted item. By default, pasted items main-
tain the original formatting from the source.     
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 Copying and Moving Selections WD1.31

Keep Source Formatting button is selected by default

Paste Options menu

  Figure 1.31 

      The following table describes the options on the Paste Options menu.         

Paste Option Description

Keep Source Formatting Pastes the item with the same formatting that it had in the source.

Merge Formatting 
Pastes the item, changing the formatting to match the surrounding 
destination text.

Keep Text Only 
Pastes text only (from a selection that is a combination of text and graphics). 
This option also strips formatting from the pasted text.

Set Default Paste Enables you to change the default paste formatting setting to another.

The selection was pasted using the same formatting it had in the source, which 
is appropriate for this sentence. You will close the Paste Options menu with-
out changing the selection. 

2

      •  Click the     

 Paste Options button.    

 Your screen should be similar 

to  Figure 1.31
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3

      •  Click outside the 

menu to close it.        

    •  Type   at     

   •  Press   z    .    

  Your screen should be similar to  

  Figure 1.32   

 Additional Information 

The Paste Options button will disappear 
as soon as you begin to type.

4

      •  Select “we” (third 

sentence, first 

paragraph).   

   •  Right-click on the 

selection and click  

    Keep Source 

Formatting from the 

context menu.    

    •  Change “are” in the 

same sentence to 

“is”.    

 Your screen should be similar 

to  Figure 1.33

  Another Method 

 You could simply have clicked    
Paste in the Clipboard group of the 
Home tab to insert the Clipboard 
contents again.  

WD1.32 Lab 1: Creating and Editing a Document

Paste Options button no longer appearsSource formatting maintained

  Figure 1.32 

      Next, you want to insert the company name in place of the word “we” in the 
first paragraph and then change the word “are” to “is”.       

Clipboard contents pasted again

  Figure 1.33 

      The selected text was deleted and replaced with the contents of the system Clip-
board. The system Clipboard contents remain in the Clipboard until another 
item is copied or cut, allowing you to paste the same item multiple times.  
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      •  Select the line of text 

“Costa Rica Rivers 

and Rainforests”.    

    •  Click      Cut in the 

Clipboard group.        

    •  Move to the “I” in the 

“Inca Trail to Machu 

Picchu” title.   

   •  Press   c     +   V.    

  Your screen should be similar 

to    Figure 1.34   

  Having Trouble? 

 Click in the margin space to the left of 
the paragraph to select it.  

 Another Method 

The Cut keyboard shortcut is  c     +  X. 
You also can choose Cut from the 
context menu.

  Additional Information 

 You also can use drag and drop to copy 
a selection by holding down  c    while 
dragging. The mouse pointer shape 

is   .  

Additional Information

Review the drag and drop feature in the 
“Using Drag and Drop”section on page 
IO.49 of the Introduction to Microsoft 
Office 2010.

 Copying and Moving Selections WD1.33

  USING CUT AND PASTE 

 You’ve decided to move the “Costa Rica Rivers and Rainforests” tour name to 
be second in the tour list. To do this, you will move the name from its current 
location to the new location. The Cut and Paste commands in the Clipboard 
group of the Home tab are used to move selections. 

Cut text copied from system 

Clipboard and inserted in document

  Figure 1.34 

      The selected text was removed from the source and copied to the Clipboard. 
Then it was reentered into the document at the cursor location. That was 
much quicker than retyping the tour name over!  

  USING DRAG AND DROP 

 Finally, you also decide to move the tour name “Safari in Tanzania” to first in 
the list. Rather than use Cut and Paste to move this text, you will use the drag-
and-drop editing feature. This feature is most useful for copying or moving 
short distances in a document. 
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      •  Select the entire line 

“Safari in Tanzania”, 

including the space 

at the end of the line.   

   •  Drag the selection to 

the left of the “India 

Wildlife Adventure” 

tour name.   

   •  Click      Save in the 

Quick Access Toolbar 

to save the file using 

the same file name.    

  Your screen should be similar 

to    Figure 1.35   

  Additional Information 

 You also can move or copy a selection 
by holding down the right mouse button 
while dragging. 

 When you release the mouse 
button, a context menu appears with the 
available move and copy options.  

 Additional Information 

Refer to the section “Formatting Text” 
on page IO.4 in the Introduction to 
Microsoft Office 2010 to review font 
and font size.

WD1.34 Lab 1: Creating and Editing a Document

Selection 

moved using 

drag and drop

  Figure 1.35 

      The selection is moved to the new location. As you are working on a docu-
ment, it is a good idea to save your document frequently to prevent the acci-
dental loss of work from a power outage or other mishap. While AutoRecover 
is a great feature for recovering lost work, it should not be used in place of 
regularly saving your work.    

  Formatting a Document 

  Because this document is a flyer, you want it to be interesting to look at and 
easy to read. Applying different formatting to characters and paragraphs can 
greatly enhance the appearance of the document.    Character formatting  
consists of formatting features that affect the selected characters only. This 
includes changing the character style and size, applying effects such as bold 
and italics to characters, changing the character spacing, and adding ani-
mated text effects. Paragraph formatting features affect an entire paragraph. A 
paragraph consists of all text up to and including the paragraph mark.    Para-
graph formatting    features include how the paragraph is positioned or aligned 
between the margins, paragraph indentation, spacing above and below a para-
graph, and line spacing within a paragraph.  

   CHANGING FONTS AND FONT SIZES 

 The first formatting change you want to make is to use different fonts and 
font sizes in the flyer. Using fonts as a design element can add interest to your 
document and give readers visual cues to help them find information quickly.       
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      •  Triple-click in the 

left margin when the 

mouse pointer is     

 to select the entire 

document.        

    •  From the Font group, 

open the      Font 

Size drop-down list.        

  Your screen should be similar 

to    Figure 1.36   

 Another Method 

The keyboard shortcut 
is  c     +   s     +  P.

 Another Method 

The keyboard shortcut is  c     +  A.

 Formatting a Document WD1.35

  Two basic types of fonts are serif and sans serif.    Serif fonts    have a flair 
at the base of each letter that visually leads the reader to the next letter. Two 
common serif fonts are Roman and Times New Roman.    Sans serif fonts    don’t 
have a flair at the base of each letter and are generally used for text in para-
graphs. Arial and Calibri are two common sans serif fonts. Because sans serif 
fonts have a clean look, they are often used for headings in documents. A good 
practice is to use only two types of fonts in a document, one for text and one 
for headings. Using too many different font styles can make your document 
look cluttered and unprofessional.  

Several common fonts in different sizes are shown in the table below.

Font Name Font Type Font Size

Arial Sans serif This is 10 pt.

This is 16 pt.
Courier New Serif This is 10 pt.

This is 16 pt.
Times New Roman Serif This is 10 pt.

This is 16 pt.

 To change the font before typing the text, use the command and then type. All 
text will appear in the specified setting until another font setting is selected. To 
change a font setting for existing text, select the text you want to change and 
then use the command. If you want to apply font formatting to a word, simply 
move the cursor to the word and the formatting is automatically applied to the 
entire word. 

 First you want to increase the font size of all the text in the flyer to make 
it easier to read. Currently, you can see from the Font Size button in the Font 
group that the font size is 11 points. 

Current 

font size Click the down arrow to display 

the Font Size drop-down list

Current font

  Figure 1.36 
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      Additional Information 

 If a selection includes text of various 
sizes, the Font Size button will be blank.  

Refer to the Section

“Formatting Text” on page IO.40 in the 
Introduction to Microsoft Office 2010 to
review the Live Preview feature.

WD1.36 Lab 1: Creating and Editing a Document

      The current (default) font size of 11 is selected. You will increase the font 
size to 14 points. As you point to the size options, the Live Preview feature 
shows how the selected text in the document will appear if chosen.  

New font size

  Figure 1.37 

 The font size of all text in the document has increased to 14 points, making 
the text much easier to read. The Font Size button displays the new point size 
setting for the text at the location of the cursor. 

 Next you will change the font and size of the two title lines. First you will 
change the font to Comic Sans MS and then you will increase the font size. 
Many of the formatting commands are on the Mini toolbar that appears when-
ever you select text. 

2

      •  Point to several 

different point sizes 

in the list to see the 

Live Preview.   

   •  Click 14 to choose it.    

  Your screen should be similar 

to    Figure 1.37   
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      •  Select the two title 

lines and point to the 

Mini toolbar.   

   •  Open the     

 Font drop-down 

menu in the Mini 

toolbar.   

   •  Scroll the list and 

choose Comic Sans 

MS.        

  Your screen should be similar 

to    Figure 1.38   

 Additional Information 

Font names are listed in alphabetical 
order.

  Having Trouble? 

 If this font is not available on your 
computer, choose a similar font.  

 Formatting a Document WD1.37

New font applied

  Figure 1.38 

      Using the Mini toolbar to apply the formats is a quick and convenient alterna-
tive to using the Ribbon. Next, you will change the font size. 

      

New font size

  Figure 1.39 

4

      •  Open the     

 Font Size drop-down 

menu in the Mini 

toolbar.   

   •  Choose 36.    

 Your screen should be similar 

to  Figure 1.39

Mini toolbar
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      •  Select the list of four 

tours.   

   •  Click     

 Font in the Mini 

toolbar and change 

the font to Comic 

Sans MS.    

    •  Click anywhere on 

the highlighted text 

to deselect it.   

   •  Reduce the zoom so 

the entire page is 

visible.    

 Your screen should be similar 

to  Figure 1.41

  Additional Information 

 Theme fonts and recently used fonts 
appear at the top of the list. You will 
learn about themes in Lab 3.  

WD1.38 Lab 1: Creating and Editing a Document

      The selected font and size have been applied to the selection, making the title 
lines much more interesting and eye-catching. The Font and Font Size buttons 
reflect the settings in use in the selection. As you look at the title lines, you decide 
the font size of the first title line is too large. You will reduce it to 20 points. 

New font size

  Figure 1.40 

      Finally, you want to change the font of the list of four tours. 

New font

  Figure 1.41 

5

      •  Select the first title 

line.   

   •  Click  and 

choose 20 points    

 Font Size drop-down 

menu.    

  Your screen should be similar 

to    Figure 1.40   
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      The changes you have made to the font and font size have made the flyer some-
what more interesting. However, you want to further enhance the document.  

  APPLYING CHARACTER EFFECTS 

 Next you want to liven up the flyer by adding character effects such as color 
and bold to selected areas. The table below describes some of the effects and 
their uses.           

Format Example Use

Bold, italic Bold Italic Adds emphasis.

Underline Underline Adds emphasis.

Strikethrough Strikethrough Indicates words to be deleted.

Double strikethrough Double Strikethrough Indicates words to be deleted.

Superscript “To be or not to be.”1 Used in footnotes and formulas.

Subscript H2O Used in formulas.

Shadow Shadow Adds distinction to titles and headings.

Outline OutlineOutline Adds distinction to titles and headings.

Emboss Emboss Adds distinction to titles and headings.

Engrave Engrave Adds distinction to titles and headings.

Small caps SMALL CAPS Adds emphasis when case is not important.

All caps ALL CAPS Adds emphasis when case is not important.

Hidden Prevents selected text from displaying or printing. 
Hidden text can be viewed by displaying formatting 
marks.

Color Color Color Color Adds interest

 First you will add color and bold to the top title line. The default font color 
setting is Automatic. This setting automatically determines when to use black 
or white text. Black text is used on a light background and white text on a dark 
background. 

Shadow

Emboss

Engrave
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      •  Return the zoom to 

100%.   

   •  Select the first title 

line and point to the 

Mini toolbar.   

   •  Open the      Font 

Color drop-down list 

on the Mini toolbar.   

        

   •  Choose      Orange 

from the Standard 

Colors bar.      

    •  Click      Bold on the 

Mini toolbar.    

    •  Click on the title line 

to clear the selection.    

 Your screen should be similar 

to  Figure 1.42

     Additional Information 

 A ScreenTip displays the name of the 
color when selected. 

  Another Method 

 The keyboard shortcut is  c     +  B.  

WD1.40 Lab 1: Creating and Editing a Document

Color and bold applied to text

  Figure 1.42 

      The buttons reflect the settings associated with the text at the insertion point. 
The Font Color button appears in the last selected color. This color can be 
quickly applied to other selections now simply by clicking the button. 
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      •  Select the second 

title line.   

   •  Using the Mini 

toolbar, change the 

font color to green 

using the Standard 

Colors bar.   

   •  Add bold to the 

selected title.   

   •  Select the list of four 

tours.   

   •  Click      Font Color 

to change the color to 

green.    

    •  Click      Bold,  

 Italic.   

   •  Click      Italic again 

to remove the italic 

effect.    

    •  Apply bold, italic, and 

orange font color to 

the last sentence of 

the flyer.   

   •  Click in the document 

to deselect the text.    

 Your screen should be similar 

to  Figure 1.43

  Additional Information 

 The currently selected font color can 
be applied to the selection simply by 
clicking the button.  

  Additional Information 

 Many formatting commands are toggle 
commands. This means the feature can 
be turned on and off simply by clicking 
on the command button.  

 Formatting a Document WD1.41

 Next you will add color and bold to several other areas of the flyer. 

Color and bold effect added to text

Color, bold, and italic effect added to text

  Figure 1.43 

      The character formatting effects you added to the flyer make it much more 
interesting. 
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WD1.42 Lab 1: Creating and Editing a Document

 The next formatting change you want to make is to apply the Small Caps 
effect to the title lines. Since the Ribbon does not display a button for this fea-
ture, you need to open the Font dialog box to access this feature. 

Current font and style

Font description

Preview box 

displays example of 

current selections

  Figure 1.44 

      The Font dialog box contains all of the Font commands in the Font group 
and more. Using the Dialog Box Launcher to open a dialog box allows you to 
access the more-advanced or less-used features of a group. The font and font 
style used in the selected text are identified in the list boxes. However, because 
the selection includes two different font sizes and colors, these settings are not 
identified. 

 The Preview box displays an example of the currently selected font setting. 
Notice the description of the font below the Preview box. It states that the 
selected font is a TrueType font.    TrueType    fonts are fonts that are automati-
cally installed when you install Windows. They appear onscreen exactly as 
they will appear when printed. Some fonts are printer fonts, which are avail-
able only on your printer and may look different onscreen than when printed. 
Courier is an example of a printer font. 

3

      •  Select both title lines.   

   •  Click      in the 

bottom-right corner 

of the Font group to 

open the Font dialog 

box.    

 Your screen should be similar 

to  Figure 1.44
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 Formatting a Document WD1.43

 You will add the Small caps effect to the selected lines. 

Small Caps effect 

applied to selection

  Figure 1.45 

      The Small caps effect has been applied to all text in the selection and adds 
more emphasis to the title lines.  

  SETTING PARAGRAPH ALIGNMENT 

 The final formatting change you want to make is to change the paragraph 
alignment. 

4

      •  Choose Small caps.   

   •  Click     .    

 Your screen should be similar 

to  Figure 1.45
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WD1.44 Lab 1: Creating and Editing a Document

 The commands to change paragraph alignment are available in the Paragraph 
dialog box. However, it is much faster to use the keyboard shortcuts or com-
mand buttons in the Paragraph group shown below.           

Alignment Keyboard Shortcut Button

Left c + L

Center c + E

Right c + R

Justify c + J

       Alignment    is the positioning of text on a line between the margins or indents. There are four types of paragraph 
alignment: left, centered, right, and justified. The alignment settings affect entire paragraphs and are described 
in the table below.     

Alignment Effect on Text Alignment

 

Left Aligns text against the left margin of the page, leaving the right margin 
ragged or uneven. This is the most commonly used paragraph align-
ment type, and therefore the default setting in all word processing 
software packages.

 

Center Centers each line of text between the left and right margins. Center 
alignment is used mostly for headings or centering graphics on a page.

 

Right Aligns text against the right margin, leaving the left margin ragged. Use 
right alignment when you want text to line up on the outside of a page, 
such as a chapter title or a header.

 

Justify Aligns text against the right and left margins and evenly spaces out 
the words by inserting extra spaces, called soft spaces, that adjust 
automatically whenever additions or deletions are made to the text. 
Newspapers commonly use justified alignment so the columns of text 
are even.

5Concept Alignment
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      •  Triple-click in the left 

margin to select the 

entire document.   

   •  Click      Center in 

the Mini toolbar.    

    •  Reduce the zoom so 

the entire page is 

visible.    

 Your screen should be similar 

to  Figure 1.46

  Another Method 
 You also can use    in the Paragraph 
group of the Home tab or choose 
Centered from the Alignment list box 
in the Paragraph dialog box.  

 Additional Information 

The alignment settings also can be 
specified before typing in new text. As 
you type, the text is aligned according 
to your selection until the alignment 
setting is changed to another setting.

 Formatting a Document WD1.45

 You want to change the alignment of all paragraphs in the flyer from the 
default of left-aligned to centered. 

Text centered

  Figure 1.46 

      Each line of text is centered evenly between the left and right page margins.      

  CLEARING FORMATS 

 As you look at the entire flyer, you decide the last line is overformatted. You 
think it would look better if it did not include italics and color. Since it has 
been a while since you applied these formats, using Undo also would remove 
many other changes that you want to keep. Instead, you will quickly clear all 
formatting from the selection and then apply only those you want. 
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      •  Increase the zoom to 

100%.        

    •  Select the last 

sentence.   

   •  Click      Clear 

Formatting in the 

Font group.    

 Your screen should be similar 

to  Figure 1.47

 Additional Information 

In addition to using the Zoom slider, 

you can click    in the Zoom group 

of the View tab.

     Another Method 

Instead of clearing all formats, you 
could simply reselect the command 
button to remove the formats that you 
did not want or select another format to 
replace it.

WD1.46 Lab 1: Creating and Editing a Document

Clears all formatting from selection

All formats cleared

  Figure 1.47 

 All formatting associated with the selection, including text alignment and 
font size, has been removed and the text appears in the default document 
font and size.         

 The formatting of the last sentence looks much better now.    

2

     •  Format the last sentence to bold, centered, and a font size of 14.   

 •  Click     Save in the Quick Access Toolbar to save the file using the same file name.
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 Additional Information 

You also can scan a picture and insert it 
directly into a Word document without 
saving it as a file first.

 Working with Graphics WD1.47

  Working with Graphics 

  Finally, you want to add a graphic to the flyer to add interest.     

 A    graphic    is a nontext element or object such as a drawing or picture that can be added to a document. An 
   object    is an item that can be sized, moved, and manipulated. 

 A graphic can be a simple    drawing object    consisting of shapes such as lines and boxes. A drawing object is 
part of your Word document. A    picture    is an illustration such as a graphic illustration or a scanned photograph. 
Pictures are graphics that were created using another program and are inserted in your Word document as 
   embedded objects.    An embedded object becomes part of the Word document and can be opened and edited 
from within the Word document using the    source program,    the program in which it was created. Any changes 
made to the embedded object are not made to the original picture file because they are independent. Several 
examples of drawing objects and pictures are shown below.       

Add graphics to your documents to help the reader understand concepts, to add interest, and to make your 
document stand out from others.

6 Concept  

Drawing object Graphic illustration Photograph

 Graphics 

 Pictures can be obtained from a variety of sources. Many simple drawings 
called    clip art    are available in the Clip Organizer, a Microsoft Office tool that 
arranges and catalogs clip art and other media files stored on the computer’s 
hard disk. Additionally, you can access Microsoft’s Clip Art and Media Web 
site for even more graphics. 

 Digital images created using a digital camera are one of the most common 
types of graphic files. You also can create picture files using a scanner to con-
vert any printed document, including photographs, to an electronic format. 
Most images that are scanned and inserted into documents are stored as Win-
dows bitmap files (.bmp). All types of pictures, including clip art, photographs, 
and other types of images, can be found on the Internet. These files are com-
monly stored as .jpg or .pcx files. Keep in mind that any images you locate on 
the Internet may be copyrighted and should only be used with permission. 
You also can purchase CDs containing graphics for your use.      
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  Additional Information 

 You will learn more about the Picture 
Tools tab features in later labs.  

WD1.48 Lab 1: Creating and Editing a Document

   INSERTING A PICTURE FROM FILES 

 You want to add a picture to the flyer below the two title lines. You will move 
to the location in the document where you want to insert a photograph of a 
lion you recently received from a client. The photograph has been saved as a 
picture image. 

Tab contains commands to modify picture objects

Selected picture 

inserted and centered 

in document

Sizing handle

Selection 

rectangle

  Figure 1.48 

      The picture is inserted in the document at the location of the cursor. It is cen-
tered because the paragraph in which it was placed is centered. Notice the pic-
ture is surrounded by a    selection rectangle    and four circles and four squares, 
called    sizing handles,    indicating it is a selected object and can now be deleted, 
sized, moved, or modified. A Picture Tools tab automatically appears and can 
be used to modify the selected picture object.  

1

      •  Move to the blank 

line below the second 

title line.   

   •  Open the Insert tab.   

   •  From the Illustrations 

group, click  

 

   .   

   •  Select the location 

containing your data 

files.   

   •  Select wd01_Lion.   

   •  Click     .    

 Your screen should be similar 

to  Figure 1.48
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 Working with Graphics WD1.49

  INSERTING A PICTURE FROM CLIP ART 

 Although you like the picture of the lions that you might see on one of the 
tours, you want to check the Clip Art Gallery to see if you can locate a better 
animal picture. 

Enter descriptive word

Select types of 

files to locate

Access graphics on the 

Office.com Web site

Clip Art task pane

  Figure 1.49 

      The Clip Art task pane appears in which you can enter a word or phrase that 
is representative of the type of picture you want to locate. You also can specify 
the locations to search and the type of media files, such as clip art, movies, 
photographs, or sound, to display in the results. You want to find clip art and 
photographs of animals. 

1

      •  Click to the right 

side of the graphic to 

deselect it.   

   •  Open the Insert tab.   

   •  From the Illustrations 

group, click     .    

 Your screen should be similar 

to  Figure 1.49
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      Having Trouble? 

 Your Clip Art task pane may display 
different pictures than shown in 
 Figure 1.50 .  

2

      •  If necessary, select 

any existing text in 

the Search For text 

box.   

   •  Type   animals     

   •  If necessary, select 

the Include    Office.

com    content check 

box.        

    •  Open the Results 

Should Be drop-

down list, select 

Illustrations and 

Photographs, and 

deselect all other 

options.   

   •  Click     .    

 Your screen should be similar 

to  Figure 1.50

 Having Trouble? 

Click the box next to an option to select 
or deselect (clear the checkmark).

WD1.50 Lab 1: Creating and Editing a Document

Thumbnails of 

photographs and clip 

art of animals

Search for “animals”

  Figure 1.50 

 The program searches the Microsoft Clip Organizer on your computer and, if 
you have an Internet connection established, Microsoft’s Office Online site for 
clip art and graphics that match your search term. The Results area displays 
  thumbnails,    miniature representations of pictures, of all located graphics. 
The pictures stored in the Microsoft Clip Organizer appear first in the results 
list, followed by the Office Online clip art. 

 Pointing to a thumbnail displays a ScreenTip containing the keywords asso-
ciated with the picture and information about the picture properties. It also 
displays a drop-down list bar that accesses the item’s context menu. 
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Access selected 

item’s context menu

ScreenTip

  Figure 1.51 

      Each graphic has several keywords associated with it. All the displayed graph-
ics include the keyword “animals.” Because so many pictures were located, 
you decide to narrow your search to display pictures with keywords of “ani-
mals” and “parrots” only. Additionally, because it is sometimes difficult to see 
the graphic, you can preview it in a larger size. 

3

      •  Scroll the list to view 

additional images.   

   •  Point to any 

thumbnail to see a 

ScreenTip.    

 Your screen should be similar 

to  Figure 1.51
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      •  Add a comma and 

a space after the 

word “animals” in 

the Search For text 

box and then type  

 parrots     

   •  Click     .   

   •  Scroll the results 

area, if necessary, 

and point to the 

graphic of the parrot 

shown in    Figure 1.52   .   

   •  Click      next to the 

graphic to open the 

context menu.   

   •  Choose Preview/

Properties.        

 Your screen should be similar 

to  Figure 1.52

 Additional Information 

If you cannot find the picture of the 
parrot shown in  Figure 1.52 , it is 
provided with the files downloaded for 

the lab as wd01_Parrot. Use 

to insert it into the flyer.

WD1.52 Lab 1: Creating and Editing a Document

Preview/Properties dialog box provides more 

information about selected graphic Close Clip Art task pane

  Figure 1.52 

      Because the search term is more specific, fewer results are displayed. The 
 Preview/Properties dialog box displays the selected graphic larger so it is eas-
ier to see. It also displays more information about the properties associated 
with the graphic, including the keywords used to identify the graphic. You 
think this looks like a good choice and will insert it into the document. 
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      •  Click      to 

close the dialog box.   

   •  Click on the graphic 

to insert it in the 

document.        

    •  Click      in the Clip 

Art task pane title bar 

to close it.   

   •  Scroll the document, 

if necessary, to view 

the pictures in their 

entirety.    

 Your screen should be similar 

to  Figure 1.53

 Another Method 

You also could choose Insert from the 
thumbnail’s context menu.

 Working with Graphics WD1.53

Second 

graphic is 

inserted in 

document

  Figure 1.53 

      The clip art graphic is inserted next to the lion picture. You will reduce the size 
of the clip art graphic shortly.  

  DELETING A GRAPHIC 

 There are now two graphics in the flyer. You decide to use the parrot graphic 
and need to remove the picture of the lion. To do this, you select the graphic 
and delete it. 

      

Picture of lion 

deleted

  Figure 1.54 

      The lion graphic is removed and the parrot graphic is centered on the page.  

1

      •  Click on the lion 

graphic to select it.   

   •  Press   D    .    

 Your screen should be similar 

to  Figure 1.54
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  Additional Information 

 A selected graphic object can be moved 
by dragging it to the new location.  

 Another Method 

You also can size a picture to an exact 
measurement using commands in the 
Size group of the Picture Tools tab.

1

      •  Click on the graphic 

to select it.   

   •  Point to the lower-

right corner handle.    

    •  With the pointer as 
a     , drag inward to 

decrease the size to 

approximately 1.25 

inches wide by 2 

inches high (use the 

ruler as a guide and 

refer to    Figure 1.55   ).   

   •  Click anywhere in the 

document to deselect 

the graphic.   

   •  Reduce the zoom to 

display the entire 

page.    

  Your screen should be similar 

to    Figure 1.55   

  Additional Information 

 Dragging a corner handle maintains the 
original proportions of the graphic.  

WD1.54 Lab 1: Creating and Editing a Document

  SIZING A GRAPHIC 

 Usually, when a graphic is inserted, its size will need to be adjusted. A graphic 
object can be manipulated in many ways. You can change its size; add cap-
tions, borders, or shading; or move it to another location. A graphic object 
can be moved anywhere on the page, including in the margins or on top of or 
below other objects, including text. The only places you cannot place a graphic 
object are into a footnote, endnote, or caption.     

 In this case, you want to decrease the picture’s size. To size a graphic, you 
select it and drag the sizing handles to increase or decrease the size of the 
object. The mouse pointer changes to    when pointing to a handle. The 
direction of the arrow indicates the direction in which you can drag to size 
the graphic. You want to increase the image to approximately 1 inch wide by 
1.5 inches high. 

Picture decreased in size

  Figure 1.55 

  ADDING A WATERMARK 

 The final change you want to make to the flyer for now is to add a watermark 
in the page background.    Watermarks    are text or pictures that appear behind 
document text. They often add interest or identify the document status, such 
as marking a document as a Draft. You can insert a predesigned watermark 
from a gallery of watermark text, or you can insert a watermark with custom 
text. The watermark feature affects an entire page and is found in the Page 
Layout tab. 

 You have decided to add a watermark to the background of the flyer identi-
fying the document as a draft. 
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      •  Open the Page Layout 

tab.   

   •  Click     

 from the Page 

Background group.   

   •  Scroll the Watermark 

gallery and choose 

the Draft 1 design 

from the Disclaimers 

section.   

   •  Click      Save.    

 Your screen should be similar 

to  Figure 1.56

     Additional Information 

You can only see watermarks in Print 
Layout view and Full Screen Reading 
view or in a printed document.

 Additional Information 

Choose Remove Watermark from the 

   menu to remove a 

watermark.

 Working with Graphics WD1.55

Opens Watermark gallery

Draft 1 watermark design 

added to page background

  Figure 1.56          

 The DRAFT watermark appears diagonally across the background of the page. 
The entire page is displayed as it will appear when printed. The flyer looks 
good and does not appear to need any further modifications immediately.  
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1

      •  Increase the zoom to 

100%.   

   •  Press   c     +   j    

 and then press  

 z    .   

   •  Type   Your Name 
will gladly help 
with all of your 
questions.   as the 

last sentence of the 

flyer.    

  Your screen should be similar 

to    Figure 1.57   

Having Trouble?

 If your document now extends beyond 
a single page, reduce the size of the 
graphic slightly. If resizing the graphic 
does not work, check for and delete 
any extra blank lines at the end of the 
document. 

Additional Information

Review document properties in the 
“Specifying Document Properties” 
section on page IO.51 of the Introduction 
to Microsoft Office 2010.

WD1.56 Lab 1: Creating and Editing a Document

  MODIFYING DOCUMENT PROPERTIES 

 Before printing the document for your manager, you will add a sentence to the 
flyer that includes your name and edit the document properties. 

Inserted sentence

  Figure 1.57 

 Next, you will look at the document properties that are automatically 
included with the Flyer1 file. You also will add documentation to identify 
you as the author, and specify a document title and keywords to describe the 
document. 
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Additional Information

Review previewing and printing in the 
“Printing a Document” section on page 
IO.56 of the Introduction to Microsoft 
Office 2010.

 Printing a Document WD1.57

File properties in 

expanded view

  Figure 1.58 

    You are now finished entering document properties.    

  Printing a Document 

  Although you still plan to make several formatting changes to the document, 
you want to give a copy of the flyer to your manager to get feedback regarding 
its content and layout.  

   PREVIEWING THE DOCUMENT 

 As part of the printing process, Word automatically displays a preview image 
of your document, showing you exactly how the document will appear when 
printed. 

2

      •  Open the File tab 

and then click the 

Show All Properties 

link below the list of 

properties.   

   •  Enter   New Tours 
Flyer in the Title 

text box.     

   •  Enter   Flyer   in the 

Tags text box.   

   •  Enter   First Draft  

 as the Status.   

   •  Enter   Advertising   

as the category.   

   •  Enter   Four new 
tours   as the 

Subject.   

   •  Type   your name  

 in the Author text 

box.    

 Your screen should be similar 

to  Figure 1.58
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Currently selected printer

Document 

preview

  Figure 1.59 

      A preview image of your document displays on the right side of your screen. 
This image of the flyer should be similar to the document shown in the Case 
Study at the beginning of the lab.         

 You will now print the document using the default print settings. 

 Your printer should be printing the document. 
 You are finished working on the flyer for now and want to save the proper-

ties you entered. 

 The flyer is saved and the document window is empty.    

1

      •  If necessary, make 

sure your printer is 

on and ready to print.   

   •  Choose Print on the 

File tab.    

 Your screen should be similar 

to  Figure 1.59

2

      •  If you need to change the selected printer to another printer, open the Printer drop-down list box and select the 

appropriate printer (your instructor will tell you which printer to select).   

   •  Click     .    

3

      •  Click      Save.   

   •  Open the File tab and click .    

NOTE Please consult your instructor for printing procedures that may differ from the following 

directions.
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     Having Trouble? 

If you do not have access to Office 
Online, no templates will display in the 
 Office.com  Templates area. If this is your 
situation, open the file wd01_Elegant 
Memo from your data files location.

 Working with Templates WD1.59

  Working with Templates 

  You would like to give a copy of the completed flyer to your manager Maria 
Salverez for feedback along with a cover memo. You will begin by creating a 
memo using one of the document templates included in Word. 

 A    template    is a document file that stores predefined settings and other elements such as graphics for use as 
a pattern when creating documents. The    Normal document template    automatically opens whenever you start 
Word 2010. Settings such as a Calibri 11-point font, left-alignment, and 1-inch margin are included in the Nor-
mal template. So far, you have only used the Normal document template as a basis for your documents. 

 In addition to this template, Word also includes many other templates that are designed specifically to help 
you create professional-looking business documents such as letters, faxes, reports, brochures, press releases, 
manuals, newsletters, resumes, invoices, purchase orders, and Web pages. Many of the templates are already 
installed and are available within Word. Many more are available at the Microsoft Office Online Templates Web 
page. The settings included in these specialized templates are available only to documents based on that tem-
plate. You also can design and save your own document templates. 

 All template files have a .dotx file extension and are stored in the Templates folder. The Normal document 
template, for example, is named Normal.dotx. When you create a new document from a template file, a copy of 
the file is opened and the file type changes to a Word document (.docx). This prevents accidentally overwriting 
the template file when the file is saved.  

7  Concept   Templates 

 You will now start a new document using one of Word’s memo templates. This 
template file is available at the Microsoft Office.com Web site. You will then 
change different elements in the template to give it your own personal style. 

Currently selected template (based on Normal.dotx)

Template categories at 

Microsoft Office Online Web site

Preview 

of selected 

template

  Figure 1.60     

1

      •  Open the File tab 

and choose New to 

display the available 

templates.    

  Your screen should be similar 

to    Figure 1.60   
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WD1.60 Lab 1: Creating and Editing a Document

The templates are categorized by topic. You will look in the Memo category to 
find a template to use for your memo to the manager.

Current template category

Description of 

selected template

Copies template 

to your computer

Preview of selected 

template

  Figure 1.61 

      Word displays a gallery of memo templates in different designs and the Preview 
area displays how the selected template looks. You will use the Memo (Elegant 
design) template to create your memo. Because this template is stored on the 
Office Online Web site, you need to download it to your computer. It will then 
open automatically for you in Word. 

New document based on the 

Memo (Elegant design) template

Placeholders

  Figure 1.62 

3

    •  Click     .   

   •  Change the zoom to 

page width.    

 Your screen should be similar 

to  Figure 1.62

2

    •  From the    Office.com   

 Templates section, 

choose Memos.    

     •  Select the Memo 

(Elegant design) 

template.   

 Your screen should be similar 

to  Figure 1.61
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Additional Information

During a Word session as new 
documents are opened, they are named 
Document followed by a sequential 
number.

 Working with Templates WD1.61

    A copy of the memo template is opened as a new Word document and is dis-
played in Print Layout view. The file name “Document2” appears in the Title 
bar, indicating that the current document hasn’t yet been saved. The template 
itself, however, is saved to your computer so that you can open and use it 
again without having to download it again. 

  REPLACING PLACEHOLDERS 

 Templates often include    placeholders,    which are graphic elements, com-
monly enclosed in brackets, that are designed to contain specific types of 
information. You edit placeholders to contain the information you want by 
clicking on the placeholder to select it and then typing the new information. 

 You will modify the memo header, which includes placeholders for identify-
ing the recipient, sender, subject, date and a “CC:” (carbon or courtesy copy) 
recipient. 

      

Replaced placeholders 

automatically formatted 

with all capital letters

  Figure 1.63 

      As a result of formatting selections stored in the memo template, the text you 
typed was automatically formatted in all capital letters. After you type text 
into a placeholder, the placeholder usually changes into normal text. This is 
true of all the placeholders in the Memo (Elegant design) template. 

 The computer’s system date was automatically inserted in the Date: place-
holder. As a result, the current date might not be displaying in the memo. You 
have decided not to use the CC: placeholder, so you will delete it and its iden-
tifying text. 

1

      •  Click the To: 

placeholder.   

   •  Type   Maria 
Salverez     

   •  Click the From: 

placeholder and type  

 your name     

   •  Click the Subject: 

placeholder and 

type   Adventure 
Travel Tours 
Flyer      

 Your screen should be similar 

to  Figure 1.63
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CC: placeholder deleted

Template 

instructions will be 

deleted and replaced 

with typed text

  Figure 1.64 

  ENTERING BODY TEXT 

 Next you will type a few sentences into the body of the memo. The template 
currently includes a title and some instructions on how to use the memo tem-
plate. You will select this text and replace it with your own. 

Typed body text replaced 

template instructions

  Figure 1.65 

2

      •  If the date displaying 

in the Date: 

placeholder isn’t 

the current date, 

double-click on the 

placeholder and type 

in the correct date.   

   •  Click the CC: 

placeholder and then 

press   D    .    

   •  Select the text “CC:” 

and then press  

 D    .    

  Your screen should be similar 

to    Figure 1.64   

1

      •  Select the title and 

following paragraph 

located below the 

last horizontal line.   

   •  Type   Maria, 
please review 
the draft of the 
flyer I created 
announcing 
our new travel 
adventures. 
I look forward 
to receiving 
your feedback. 
Thanks!    

  Your screen should be similar 

to    Figure 1.65   
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Additional Information

Review exiting in the “Exiting an Office 
2010 application” section on page IO.65 
of the Introduction to Microsoft Office 
2010.

 Exiting Word WD1.63

      The text you typed replaced the selected text. The memo is now complete. You 
want to save it and exit the Word application.    

 Exiting Word 

 The    command in the File menu or the    Exit button in the appli-
cation window title bar are used to quit the Word program. If you attempt to 
exit the application without first saving your document, Word displays a warn-
ing asking if you want to save your work. If you do not save your work and you 
exit the application, any changes you made since last saving it are lost. 

 The memo is saved as Flyer Memo.docx to the location you selected, the 
document is closed and the application exited. The original template file is 
unchanged on your computer so you can use it again to create another memo.           

1

      •  Open the File tab and click  .   

   •  Click      and select your solution file location.   

   •  In the File name text box, change the proposed file name to Flyer Memo.   

   •  Click     .    

 EXPLORE YOUR CAREER OPTIONS 

 Food Service Manager 
Have you noticed flyers around your campus advertising job 

positions? Many of these jobs are in the food service industry. 

Food service managers are traditionally responsible for over-

seeing the kitchen and dining room. However, these positions 

increasingly involve administrative tasks, including recruiting 

new employees. As a food service manager, your position 

would likely include creating newspaper notices and flyers 

to attract new staff. These flyers should be eye-catching and 

error-free. The typical salary range of a food service manager 

is $34,000 to $41,700. Demand for skilled food service man-

agers is expected to increase through 2012.

 FOCUS ON CAREERS 
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WD1.64 Lab 1: Creating and Editing a Document

 Creating and Editing a Document Lab 1 CONCEPT SUMMARY

Grammar Checker

   Grammar Checker (WD1.12)  

 The grammar checker advises you 
of incorrect grammar as you create 
and edit a document, and proposes 
possible corrections.  

   Spelling Checker (WD1.14)  

 The spelling checker advises you 
of misspelled words as you create 
and edit a document, and proposes 
possible corrections.  

   AutoCorrect (WD1.16)

 The AutoCorrect feature makes 
some basic assumptions about the 
text you are typing and, based on 
these assumptions, automatically 
corrects the entry.  

Spelling Checker

AutoCorrect
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Word Wrap

Fonts and Font Size

Alignment

Graphics

Template

 Concept Summary WD1.65

   Word Wrap (WD1.19)  

 The word wrap feature 
automatically decides where to end 
a line and wraps text to the next 
line based on the margin settings.  

   Alignment (WD1.44)  

 Alignment is the positioning of text 
on a line between the margins or 
indents. There are four types of 
paragraph alignment: left, centered, 
right, and justified.  

   Graphics (WD1.47)  

 A graphic is a nontext element or 
object such as a drawing or picture 
that can be added to a document.  

   Templates (WD1.59)  

 A template is a document file that 
stores predefined settings and 
other elements such as graphics 
for use as a pattern when creating 
documents.  
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     KEY TERMS 
    alignment WD1.44   
   AutoCorrect WD1.16   
   character formatting WD1.34   
   clip art WD1.47   
   cursor WD1.5   
   custom dictionary WD1.14   
   default WD1.7   
   document window WD1.5   
   drawing object WD1.47   
   edit WD1.4   
   embedded object WD1.47   
   end-of-file marker WD1.8   
   format WD1.4   
   grammar checker WD1.12   
   graphic WD1.47   
   Insert mode WD1.23   
   insertion point WD1.5   
   main dictionary WD1.14   

   Normal document template WD1.59   
   object WD1.47   
   paragraph formatting WD1.34   
   picture WD1.47   
   placeholder WD1.61   
   ruler WD1.5   
   sans serif font WD1.35   
   selection rectangle WD1.48   
   serif font WD1.35   
   sizing handles WD1.48   
   soft space WD1.44   
   source program WD1.47   
   spelling checker WD1.14   
   template WD1.59   
   thumbnail WD1.50   
   TrueType WD1.42   
   watermark WD1.54   
   word wrap WD1.19      

  LAB REVIEW   Lab 1  Creating and Editing a Document 
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 Lab Review WD1.67

  COMMAND SUMMARY           

Command Shortcut Action

Quick Access Toolbar

 Save c + S Saves document using same file name

 
Undo c + Z Restores last editing change

 
Redo c + Y Restores last Undo or repeats last command or action

File tab

New c + N Opens new blank document or specialized template

c + O Opens existing document file

c + S Saves document using same file name

= Saves document using a new file name, type, and/or location

Print c + P Prints document

Change options for working with Word

c + 4 Closes document

a + 4 Exit Word application

Home tab

Clipboard group

 Copy c + C Copies selection to Clipboard

 Cut c + X Cuts selection to Clipboard

 Paste c + V Pastes items from Clipboard

Font group

 Font Changes typeface

 Font Size Changes font size

 
Clear Formatting Removes all formatting from selection

 Bold c + B Adds/removes bold effect

 Italic c + I Adds/removes italic effect
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WD1.68 Lab 1: Creating and Editing a Document

COMMAND SUMMARY (CONTINUED)

LAB REVIEW   
Command Shortcut Action

 Change Case s + 3 Changes case of selected text

 Font Color Changes text to selected color

Paragraph group

 Show/Hide c + * Displays or hides formatting marks

 Align Text Left c + L Aligns text to left margin

 Center c + E Centers text between left and right margins

 Align Text Right c + R Aligns text to right margin

 Justify c + J Aligns text equally between left and right margins

Insert Tab

Illustrations group

 

Inserts selected picture

 

Accesses Clip Organizer and inserts selected clip

Page Layout Tab

Page Background group

 Inserts watermark behind page content

Review Tab

Proofing group

 

Opens Spelling and Grammar dialog box

View Tab

Document Views group

 

Shows how text and objects will appear on printed page

 

Displays document only, without application features
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 Lab Review WD1.69

COMMAND SUMMARY (CONTINUED)

Command Shortcut Action

 

Shows document as it will appear when viewed in a Web browser

 

Shows structure of document

 

Shows text formatting and simple layout of page

Show group

 Displays/hides ruler

Zoom group

 

Opens Zoom dialog box

 

Zooms document to 100% of normal size

 Zooms document so an entire page fits in window

 Zooms document so width of page matches width of window
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  LAB EXERCISES 

  SCREEN IDENTIFICATION 
    1. In the following Word screen, letters identify important elements. Enter the correct term for each 

screen element in the space provided. 

   Spelling and Grammar 
status icon  

  Scroll bar  
  Bold  
  Graphic  
  Save  
  Ruler  
  Close  
  Font  
  Undo  
  Zoom  

  Font color  
  Show/Hide  
  Center  
  Scrolls down  
  Redo  
  Tab mark  
  Status bar  
  Draft view  
  Ribbon  
  Paragraph Mark  
  Print Layout view   

       A.      ___________________
     B.      ___________________
      C.      ___________________
   D.  ___________________
      E.      ___________________
         F.      ___________________
    G.      ___________________
  H.      ___________________
             I.      ___________________
           J.      ___________________
    K.      ___________________

       L.      ___________________
   M.    __________________
       N.      __________________
       O.      __________________
          P.      __________________
        Q.      __________________
        R.      __________________
           S.           __________________

     Possible answers for the screen identification are:

A

B

C
D

E F G H I
J

K

M

L

NOPQ

R

S
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 Lab Exercises WD1.71

  MATCHING 
 Match the item on the left with the correct description on the right. 

____  a. undoes last command  

____  b. moves to the top of the document  

____  c. feature that automatically begins a new line when text 
reaches the right margin  

____  d. simplifies the creation of new documents  

____  e. shows dialog box  

____ f. type style that can be applied to text  

____  g. font size measurement  

____  h. controls paragraph positioning between the margins  

____ i. saves a document using the same file name  

____ j. font without a flair at the base of each letter    

    1. word wrap     

   2.        

   3.        

   4. alignment     

   5.        

   6. sans serif     

   7. template     

   8. point     

   9. font     

   10.  c     +   h         

  TRUE/FALSE 
 Circle the correct answer to the following questions.           

     1. The AutoCorrect feature automatically identifies and corrects certain types of errors.      True       False    

    2. The automatic word wrap feature checks for typing errors.      True       False    

    3. Font sizes are measured in inches.      True       False    

    4. A wavy red line indicates a potential spelling error.      True       False    

    5. The default document settings are stored in the Normal.docx file.      True       False    

    6. A selected picture is surrounded by a selection rectangle and eight moving handles.      True       False    

    7. The  D    key erases the character to the right of the cursor.      True       False    

    8. The Word document file name extension is .wrd.      True       False    

    9. Word inserts hidden marks into a document to control the display of text.      True       False    

    10. Hard spaces are used to justify text on a line.      True       False        
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  FILL-IN 
 Complete the following statements by filling in the blanks with the correct terms. 

    1. To size a graphic evenly, click and drag the   __________________ in one corner of the graphic.  

   2. A small blue box appearing under a word or character indicates that the   __________________ fea-
ture was applied.  

   3. A   __________________ is a miniature representation of all located graphics in the Clip Art task 
pane.  

   4. The __________________   feature displays each page of your document in a reduced size so you can 
see the page layout.  

   5. It is good practice to use only __________________   types of fonts in a document.  

   6. The default document settings are stored in the __________________    template file.  

   7. The   __________________ at the top of the window contains commands that are organized into 
related groups.  

   8. The   __________________ feature shows how your formatting choices will appear on selected text.  

   9. Use   __________________ when you want to keep your existing document with the original name 
and make a copy with a new name.  

   10. Word 2010 documents are identified by the   __________________ file extension.    

  MULTIPLE CHOICE 
 Circle the correct response to the questions below. 

    1. Words that are not contained in the main dictionary can be added to the   __________________ 
dictionary. 
    a. custom  
   b. additional  
   c. supplemental  

   d. user-defined    

   2. A(n) __________________   is text or pictures that appear behind document text. 
    a. graphic  
   b. watermark  
   c. embedded object  

   d. thumbnail    

   3. A(n)   __________________ is a nontext element or object that can be added to a document. 
    a. illustration  
   b. picture  
   c. drawing  

   d. all of the above    
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   4. Document development follows these steps. 
    a. plan, edit, enter, format, preview, and print  
   b. enter, edit, format, preview, and print  
   c. plan, enter, edit, format, preview, and print  

   d. design, enter, edit, format, preview, and print    

   5. This feature makes some basic assumptions about the text entered and automatically makes changes 
based on those assumptions. 
    a. AutoChange  
   b. AutoFormat  
   c. AutoText  

   d. AutoCorrect    

   6. When text is evenly aligned on both margins, it is   __________________. 
    a. centered  
   b. justified  
   c. left-aligned  

   d. right-aligned    

   7. A set of characters with a specific design is called a(n) __________________  . 
    a. style  
   b. font  
   c. AutoFormat  

   d. Design    

   8. Font sizes are measured in   __________________. 
    a. inches  
   b. points  
   c. bits  

   d. pieces    

   9. The   __________________ feature shows how various formatting choices would look on selected text. 
    a. Actual Preview  
   b. Real Preview  
   c. Active Preview  

   d. Live Preview    

   10. Words that may be spelled incorrectly in a document are indicated by a   __________________. 
    a. green wavy line  
   b. red wavy line  
   c. blue wavy line  

   d. purple dotted underline       
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 Hands-On Exercises                 LAB EXERCISE S

  STEP-BY-STEP 

  ASKING FOR INPUT MEMO È 

    1. The Lifestyle Fitness Club is planning to perform maintenance work on its facilities in the near 
future. You have been asked to solicit suggestions from existing customers about what changes they 
would like to see made to the club. You decide to send all of the current club members a memo ask-
ing them for their input. Your completed memo will be similar to the one shown here.     

    a. Open a blank Word 2010 docu-
ment and create the following 
memo in Draft view. Press  t    after 
you type the colon (:) in the memo 
header. This will make the informa-
tion following the colons line up 
evenly. Enter a blank line between 
paragraphs. 

   To: Club Members  

  From: Student Name  

  Date: [Current date]   

 The Lifestyle Fitness Club is seeking to 

improve some of its current facilities. Sev-

eral of the improvements we will make 

next year fall under the category of routine 

maintenance. For example, the current 

swimming pool has begun to age requiring 

us to close the pool for a week to repair 

several areas of cracking and chipping. We will be performing maintenance work on the sauna and steam room. 

As we enter into this season of improvements, we’d also like your feedback on how we might serve you better. 

For example, one member recently asked whether it would be possible to have additional tables near the snack 

bar. All of your suggestions are welcome and will be considered in the upcoming months. 

 Thank you in advance for your input.  

   b. Correct any spelling and grammar errors that are identified.  

   c. Turn on the display of formatting marks. Check the document and remove any extra blank 
spaces between words or at the end of lines.  

   d. Save the document as Fitness Club Memo in your solution file location.  

   e. Switch to Print Layout view.  

   f. At the beginning of the fourth sentence of the paragraph, insert the word “Simultaneously” fol-
lowed by a comma. Change the following “W” in “We” to lowercase. In the second to last sen-
tence of the paragraph, insert the words “and chairs” after the word “tables”. Delete the word 
“current” from the first and third sentences.  

RATING SYSTEM

È Easy

ÈÈ Moderate

ÈÈÈ Difficult
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   g. Start a new paragraph beginning with the fifth sentence.  

   h. Change the font size for the entire memo to 14 pt and the alignment of the body of the memo to 
justified.  

   i. Turn off the display of formatting marks.  

   j. Add an ASAP watermark.  

   k. Include your name in the document properties as author and the file name as the title.  

   l. Save the document again and print the document.      

  PROMOTING CELEBRATE BIKES SUNDAY ÈÈ 

    2. You are the program coordinator for the city of Westbrook’s Parks and Recreation Department. In next 
week’s newspaper, you plan to run an article to promote bike riding in the community through the 
Celebrate Bikes Sunday event. Your completed article will be similar to the one shown here. 

    a. Enter the following information in a 
new Word 2010 document. Press  e    
at the end of each paragraph. 

 Celebrate Bicycling! 

 May is traditionally National Bike Month, so 

take out your bicycle, tune it up and get a 

breath of fresh air! And plan to take part in 

Celebrate Bikes Sunday on 5/8 to learn about 

the benefits of bike riding. 

 As part of the activities on this day, the 

Westbrook Parks and Recreation Department 

is sponsoring a bike ride from the West Ave-

nue YMCA to the Main Street Park beginning 

at 11 am. 

 Businesses and organizations participating 

in the event are all “related to biking in 

Westbrook and most of them are involved in 

the development of the trail system,” says 

event director Mary Jo Miller. 

 At the end of the bike ride, the riders 

are encouraged to stay for the fun and 

informative activities in the park. Activities 

include a bike safety program, entertainment, 
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and food booths. The Safe Route to School program will work with parents and children to find the safest route 

to either walk or bike to school. 

 Registration is free and available by calling (603) 555-0113, visiting the YMCA during regular business hours or 

beginning at 10 am on Sunday at the YMCA.  

   b. Correct any spelling or grammar errors. Save the document as Bike Event.  

   c.  Turn on the display of formatting marks. Check the document and remove any extra blank 
spaces between words or at the end of lines.  

   d.  In Print Layout view, center the title. Change the title font to Castellar (or a font of your choice), 
22 pt, and light blue font color. Apply bold to the title.  

   e.  In the first paragraph, delete the word “traditionally” and change the number 5/8 to “May 8.” 
Add the text “and bicycle safety” to the end of the second sentence in this paragraph.  

   f.  End the sentence in paragraph 3 after the word “Park”. Change the following sentence to “The 
ride begins promptly at 11 am.”  

   g.  Delete the phrase “the riders are encouraged to” from the first sentence of the fourth paragraph.   

 h.   Move the paragraph beginning with “Businesses and organizations” to the second paragraph, 
with “As part of the activities” becoming the third paragraph. 

 i.  Add italics, bold, and light blue font color to the date in the first paragraph, the time in the third 
paragraph, and the phone number in the last paragraph. 

    j. Justify the paragraphs.  

   k. Increase the font size of the paragraphs to 12 pt.  

   l. Insert a blank line below the title.  

   m.  With the cursor on the blank line, insert a clip art graphic of your choice of a child riding a bike 
by searching on the keyword “bike” or use the graphic file wd01_Child on Bike. Center it and 
adjust the size of the graphic if necessary.  

   n.  Add your name and the current date on separate lines several lines below the last line. Left-align 
both lines. Turn off the display of formatting marks.  

   o.  Review the document and, if necessary, adjust the size of the graphic to fit the document on a 
single page.  

   p. Include your name in the file properties as author and the file name as the title.  

   q. Save the document again. Print the document.      

  ANNOUNCING MONTHLY MUSIC PERFORMANCES ÈÈ 

    3. The Downtown Internet Cafe combines the relaxed atmosphere of a coffee house with the fun of 
using the Internet. The cafe will now be hosting monthly performances featuring local musicians. 
You want to create a flyer about the monthly music performances that you can give to customers 
and also post in the window of other local businesses. Your completed flyer will be similar to the 
one shown here. 
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     You will also create the memo cov-
ersheet shown here using a Word 
template. You will then give the memo 
coversheet and flyer to Evan, the cafe 
owner for review.     

a. Open a new Word document and 
enter the following text, pressing 
e    where indicated. 

 Monthly music performances every fourth 

Sunday!  e    

 Downtown Internet Cafe  e    (2 times) 

 Come enjoy an excellent dark Italian Roast 

coffee, premium loose teas, blended drinks 

and quality light fare of sandwiches, pitas 

and salads.  e    

 Your favorite coffeehouse has recently 

added a superb sound system composed 

of quality speakers and amplifiers. Starting 

Sunday, January 24 at 3:00 p.m. we will be 

hosting performances by local musicians. 

Come by every fourth Sunday and be 

entertained!  e    

 Cafe Hours: Sunday - Thursday 8:00 a.m. to 

9:00 p.m. Friday and Saturday 8:00 a.m. to 

12:00 a.m.  e     

 2314 Telegraph Avenue  e     

   b. Correct any spelling and grammar 
errors that are identified.  

     c. Save the document as Music 
Performances.  

   d. Turn on the display of formatting 
marks. Center the entire document.  

     e. Capitalize each word of the first 
line. Change the case of the text 
“Downtown Internet Café” to 
uppercase.  

         f. Using drag and drop, move the sec-
ond paragraph, including the para-
graph mark, to the left of “C” of “Come” in the previous paragraph.  
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   g.  Using cut and paste, move the street address, including the following paragraph mark, to the 
“C” of “Café Hours”.   

   h. Insert the following three lines of text between the first and second paragraphs: 

  February 28, West Coast Bluegrass Experience      

  March 28, Vocal String Quartet      

  April 25, International Guitar Night  

   i.  Change the first line of the document to a font color of dark red, font type of Arial Black or a 
font of your choice, and size of 24 pt.  

   j.  Change the text “Downtown Internet Café” to a font color of blue, font type of Arial Narrow or a 
font of your choice, and size of 28 pt.  

   k. Select all the remaining text in the document and increase the font size to 14 pt.  

   l.  Change the three date lines below the first paragraph to a font color of purple and a font size of 
16 pt. Change the last two lines (address and hours) to a font color of dark blue. Add bold to the 
selection.  

   m.  Insert the graphic file wd01_Saxophone (from your data files) on the blank line below the title 
Downtown Internet Café at the top of the document. Size the graphic to be approximately 2 by 
2 inches using the ruler as a guide.  

   n. Add your name and the current date, left-aligned, on one line, below the last line.  

   o. If a paragraph mark is displayed to the right of the date, delete it.  

   p. Turn off the display of formatting marks.  

   q. If necessary, reduce the size of the graphic so the entire flyer fits on one page.  

   r.  Include your name in the file properties as author and the file name as the title. Save, print, and 
then close the flyer document.

 s. Start a new document based on the Memo (Contemporary design) template.   

   t. Delete the “CC” line of the memo.  

   u. Edit the placeholders as follows:

     To:  Evan   

    From:  your name   

    Re:  Downtown Internet Café Flyer      

   v. Edit the date, if necessary, to reflect the current date.  

   w.  Select the text below the horizontal border and then type  Please review the attached flyer. 
I’d like to begin handing the flyer out right away, so the sooner I receive your feedback, the 
better. Thanks!   

   x. Save the completed memo as Café Memo. Print the memo.      

LAB EXERCISES
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  PREPARING A LECTURE ON NOTE-TAKING SKILLS ÈÈÈ 

    4. You teach a college survival skills class and have recently read about the results of a survey con-
ducted by the Pilot Pen Company of America about note-taking skills. The survey of 500 teenagers 
found that students typically begin taking classroom notes by sixth grade and that only half had 
been taught how to take classroom notes. It also found that those students trained in note-taking 
earned better grades. Note-taking becomes increasingly important in high school and is essential 
in college. Lecture notes are a key component for mastering material. In response to the survey, 
the pen manufacturer came up with 10 tips for better note-taking. You started a document of these 
tips that you plan to use to supplement your lecture on this topic. You will continue to revise and 
format the document. The revised document will be similar to the one shown here.     

a. Open the Word document 
wd01_Note Taking Skills.  

   b. Correct any spelling and gram-
mar errors that are identified. 
Save the document as Note 
 Taking Skills.  

     c. Switch to Draft view. Change 
the font of the title line to a font 
of your choice, 26 pt. Center and 
add color of your choice to the 
title line.  

   d. Apply the small caps effect to 
the title line.  

     e. In the Be Ready tip, delete the 
word “lots”. In the Write Legibly 
tip, delete the word “cursive” 
and add the words “an erasable” 
before the word “pen.” Change 
the tip heading “Margins” to 
“Use Wide Margins.”  

         f. Above the Write Legibly tip, 
insert the following tip: 

 Fill in Gaps 

 Check with a classmate or your 

teacher after class to get any missing 

names, dates, facts or other informa-

tion you could not write down.  

    g. Move the Fill in Gaps tip to after the Use Wide Margins tip.  

   h. Change the font of the tip heading lines to Broadway with a font size of 16 pt and a color of your 
choice.  

          i. Change the alignment of the paragraphs to justified. Use Undo Changes to return the alignment 
to left. Use Redo Changes to return the paragraphs to justified again.  
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          j. Switch to Print Layout view. Insert a clip art graphic of your choice (search on “pencil”) below 
the title, or insert the picture named wd01_Pencils from your data files location. Size it and cen-
ter it by referring to the completed document.  

    k. Add your name and the current date, centered, on separate lines two lines below the last line. If 
needed, reduce the size of the graphic to fit the entire document on one page.  

          l. Include your name in the file properties as author and the document title as the title. Save the 
document. Print the document.      

  WRITING AN ARTICLE ON THE HISTORY OF ICE CREAM ÈÈÈ 

    5. Each month the town’s free paper prints a fun article on the history of something people are famil-
iar with but might not know anything about. You researched the topic online and found the infor-
mation you needed about the history of ice cream from the International Dairy Foods Association’s 
Web site at  www.idfa.org/news--views/media-kits/ice-cream/the-history-of-ice-cream . You started 
writing the article a few days ago and just need to continue the article by adding a few more details. 
Then you need to edit and format the 
text and include a graphic to enhance 
the appearance of the article. Your com-
pleted article will be similar to the one 
shown here.     

      a. Open the file named wd01_History of 
Ice Cream.  

   b. Correct any spelling and grammar 
errors. (Hint: Click    in the status 
bar to move to each error.) Save the 
document as Ice Cream History.  

      c. Enter the following headings at the 
location shown in parentheses. 

      History of Ice Cream  (above first 
paragraph)  

     The Evolution of Ice Cream  (above 
second paragraph)  

     Ice Cream in America  (above third 
paragraph)    

   d. Center the title “History of Ice 
Cream”. Change the font to Lucida 
Sans with a point size of 24, and add 
the Small Caps effect. Add a color of 
your choice to the title.  

      e. Change the other two headings to 
bold with a type size of 14 pt. Use 
the same color as in the title for the 
heads.  
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   f.  Move “The Evolution of Ice Cream” heading and paragraph to below the second “Ice Cream in 
America” paragraph.  

   g. Undo the move operation you performed in the last step.  

   h. Change the alignment of the first paragraph to justified.  

   i.  Add a blank line below the main title of the article and insert the picture wd01_Ice Cream (from 
your data files) at this location.  

   j. Size the picture to be 1 inch wide (use the ruler as a guide). Center it below the title.  

   k. Add a Draft watermark.  

   l.  Add your name and the current date below the last line of the article. View the whole page and, 
if necessary, reduce the size of the graphic so the entire article fits on one page.  

   m.  Include your name in the file properties as author and the document title as the title. Save the 
document again. Print the document.       

  ON YOUR OWN 

  CREATING A FLYER È 

   1. Adventure Travel Tours is offering a great deal on a Day of the Dead Bicycle Tour in Mexico. 
Research the Day of the Dead celebration using the Web as a resource. Then, using the features of 
Word you have learned so far, create a flyer that will advertise this tour. Be sure to use at least two 
colors of text, two sizes of text, and two kinds of paragraph alignment. Include a graphic from the 
Clip Organizer. Include your name at the bottom of the flyer. Include your name in the file proper-
ties as author and the file name as the title. Save the document as Mexico Adventure.    

  CREATING A FAX COVERSHEET ÈÈ 

   2. You work at the community pool and have been asked by your boss (Anna Najarian) to fax some 
information over to Asher Hayes at the local high school describing the rules swimmers should fol-
low when using the pool. Start a new document using the Fax (Equity theme) template. (If neces-
sary, open the wd01_Equity Fax template from your data files location.) Edit the template to include 
the following recipient information:  Asher Hayes  (To:),  650-555-0198  (Fax:)  650-555-0197  (Phone:), 
Pool Rules  (Re:). Include the following sender information:  Your Name  (From:),  1  (Pages:), 
Today’s Date  (Date:), and  Anna Najarian  (CC:). Select the “For Review” check box by clicking on it. 
(The box should appear shaded.) 

 Edit the Comments: placeholder to include the five most important rules to follow while swim-
ming at the pool. Use the Web as a resource for obtaining pool safety information. Place each rule 
on separate lines. Insert a piece of clip art after the list of rules. Size the image if necessary so that 
the document remains one page in length. Include your name in the file properties as author and 
the file name as the title. Save the document as Pool Rules.    
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  ASTRONOMY CLASS MEMO ÈÈÈ 

   3. The city of Gilbert, Arizona, has recently built a $100,000 observatory that includes a $20,000 tele-
scope in a local park. The observatory is open evenings for small groups of five to six people to take 
turns looking through the 16-inch telescope’s eyepiece. The use of the observatory is free. 

 The city has decided to offer classes for the community to learn how to use the telescope and 
to teach about astronomy. As a trial run, the class will first be offered to city employees and their 
families. You want to notify all employees about the observatory and the class by including a 
memo with their paycheck. Using Step-by-Step Exercise 1 as a model, provide information about 
when and where the class will be held. Include information about how people sign up for the class. 
Include your name in the file properties as author and the file name as the title. Save the memo as 
Astronomy Basics.    

  VOLUNTEER OPPORTUNITIES ÈÈÈ 

   4. Many community groups, hospitals, libraries, and churches are looking for volunteers to assist in 
their programs. Volunteering has rewards for both the volunteer and the community. Using the 
Web as a resource, research volunteer opportunities in your community. Then write a one-page 
report that includes information about two volunteer groups for which you would like to volunteer. 
Include information about what the organization does for the community. Also include the skills 
you have to offer and the amount of time you can commit as volunteer. Include a title at the top of 
the document and your name and the current date below the title. Center the title lines. Use at least 
two colors of text, two sizes of text, and two kinds of paragraph alignment. Include a graphic from 
the Clip Organizer. Include your name in the file properties as author and the file name as the title. 
Save the document as Volunteer Opportunities.    

  WRITING A CAREER REPORT ÈÈÈ 

   5. Using the library or the Web, research information about your chosen career. Write a one-page 
report about your findings that includes information on three areas: Career Description; Edu-
cational Requirements; Salary and Employment projections. Include a title at the top of the 
document and your name and the current date below the title. Center the title lines. Justify the 
paragraphs. Include your name in the file properties as author and the file name as the title. Save 
the document as Career Report.       
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